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Safety  

The caution and danger statements that this document contains can be referenced 

in the multilingual IBM  Safety  Information  document that is provided with every IBM 

TotalStorage DS4000 Storage Server. Each caution and danger statement is 

numbered for easy reference to the corresponding statements in the translated 

document. 

v   Danger:  These statements indicate situations that can be potentially lethal or 

extremely hazardous to you. A danger statement is placed just before the 

description of a potentially lethal or extremely hazardous procedure, step, or 

situation. 

v   Caution:  These statements indicate situations that can be potentially hazardous 

to you. A caution statement is placed just before the description of a potentially 

hazardous procedure step or situation. 

v   Attention:  These notices indicate possible damage to programs, devices, or 

data. An attention notice is placed just before the instruction or situation in which 

damage could occur.

Before installing this product, read the following danger and caution notices. 
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Statement  1:  

  

 

DANGER

Electrical  current  from  power,  telephone,  and  communication  cables  is 

hazardous.  

To avoid  a shock  hazard:  

v   Do  not  connect  or  disconnect  any  cables  or  perform  installation,  

maintenance,  or  reconfiguration  of  this  product  during  an  electrical  

storm.  

v   Connect  all  power  cords  to  a properly  wired  and  grounded  electrical  

outlet.  

v   Connect  to  properly  wired  outlets  any  equipment  that  will  be  attached  to  

this  product.  

v   When  possible,  use  one  hand  only  to  connect  or  disconnect  signal  

cables.  

v   Never  turn  on  any  equipment  when  there  is evidence  of  fire,  water,  or  

structural  damage.  

v   Disconnect  the  attached  power  cords,  telecommunications  systems,  

networks,  and  modems  before  you  open  the  device  covers,  unless  

instructed  otherwise  in the  installation  and  configuration  procedures.  

v   Connect  and  disconnect  cables  as  described  in the  following  table  when  

installing,  moving,  or  opening  covers  on  this  product  or  attached  

devices.

 To Connect:  To Disconnect:  

1.   Turn everything OFF. 

2.   First, attach all cables to devices. 

3.   Attach signal cables to connectors. 

4.   Attach power cords to outlet. 

5.   Turn device ON. 

1.   Turn everything OFF. 

2.   First, remove power cords from outlet. 

3.   Remove signal cables from connectors. 

4.   Remove all cables from devices. 
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Statement  3:  

  

 

CAUTION:  

When  laser  products  (such  as  CD-ROMs,  DVD  drives,  fiber  optic  devices,  or 

transmitters)  are  installed,  note  the  following:  

v   Do  not  remove  the  covers.  Removing  the  covers  of  the  laser  product  could  

result  in  exposure  to  hazardous  laser  radiation.  There  are  no  serviceable  

parts  inside  the  device.  

v   Use  of  controls  or  adjustments  or  performance  of  procedures  other  than  

those  specified  herein  might  result  in hazardous  radiation  exposure.

  

 

DANGER

Some  laser  products  contain  an  embedded  Class  3A  or  Class  3B  laser  

diode.  Note  the  following.  

Laser  radiation  when  open.  Do  not  stare  into  the  beam,  do  not  view  directly  

with  optical  instruments,  and  avoid  direct  exposure  to  the  beam.  

Class  1  Laser  statement  

  

 

IEC 825-11993 CENELEC EN 60 825 
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Statement  4:  

  

 

 

 

 

 

 

 

 

≥ 18 kg (39.7 lb) ≥ 32 kg (70.5 lb) ≥ 55 kg (121.2 lb)
  

CAUTION:  

Use  safe  practices  when  lifting.  

 Statement  5:  

  

 

CAUTION:  

The  power  control  button  on  the  device  and  the  power  switch  on  the  power  

supply  do  not  turn  off  the  electrical  current  supplied  to  the  device.  The  device  

also  might  have  more  than  one  power  cord.  To remove  all  electrical  current  

from  the  device,  ensure  that  all  power  cords  are  disconnected  from  the  power  

source.

1

2
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Statement  8:  

  

 

CAUTION:  

Never  remove  the  cover  on  a power  supply  or  any  part  that  has  the  following  

label  attached.  

  

 

Hazardous  voltage,  current,  and  energy  levels  are  present  inside  any  

component  that  has  this  label  attached.  There  are  no  serviceable  parts  inside  

these  components.  If you  suspect  a problem  with  one  of  these  parts,  contact  

a  service  technician.
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About  this  document  

This document describes procedures for adding new Fibre Channel or SATA hard 

drives or new IBM TotalStorage DS4000 drive expansion enclosures containing new 

Fibre Channel or SATA hard drives to an existing IBM DS4000 Storage Server 

configuration. This document also describes the procedure for migrating either Fibre 

Channel hard drives or IBM TotalStorage DS4000 storage expansion enclosures 

containing Fibre Channel hard drives from one DS4000 storage subsystem to 

another. 

Who should read this document 

This document is intended for system administrators who are familiar with the IBM 

TotalStorage DS4000 storage subsystem components, terminology, and DS4000 

Storage Server administrative tasks. 

Illustrations 

Illustrations contained in this document depict general visual characteristics of the 

DS4000 Storage Server, storage expansion unit, and fibre channel drive hardware 

cited. They are not intended for use as detailed DS4000 storage hardware images. 

Using this document 

Before you proceed to complete any storage addition or migration procedures 

detailed in this publication, familiarize yourself with the principles, prerequisite 

instructions at Chapter 2, “Prerequisites to adding capacity and hard drive 

migration,” on page 23, as well as the following storage addition or migration 

procedures applicable to your specific need. 

v   Chapter 3, “Adding one or more new hard drives,” on page 31 

v   Chapter 4, “Adding expansion units containing new hard drives,” on page 37 

v   Chapter 5, “Migrating one or more hard drives,” on page 47 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 55 

v   Chapter 7, “Upgrading a storage server in a functioning configuration,” on page 

63

Your familiarity with the principles, preliminary procedures, and detailed steps 

described in this document is critical to prevent loss of data availability, and in some 

cases, loss of data. If you have questions about the procedures described in this 

document, please contact the IBM Help Center in your geography for assistance. 

Important:  

1.   Do not mix SATA and Fibre Channel drives in the same enclosure. 

2.   Do not place SATA drives in a fibre channel enclosure. 

3.   Do not place fibre channel drives in a SATA enclosure. 

4.   Do not mix SATA drive expansion enclosures (EXP100) and Fibre channel drive 

enclosures (EXP710 and EXP500) in the same drive loop or DS4000 Storage 

Server.

 

© Copyright IBM Corp. 2004 xv



DS4000 installation process overview 

The following flow chart gives an overview of the DS4000 hardware and the 

DS4000 Storage Manager software installation process. Lined arrows in the flow 

chart indicate consecutive steps in the hardware and software installation process. 

Labeled arrows indicate which current documents provide detailed information about 

those steps. 

Install Process Documentation

Plan installation Connect Power and
Start Server

DS4000 Storage Server
Installation Guide

Complete SM SW
Installation

Configure Storage
Hardware

Online Help

Configure Storage
Subsystems on Host

Verify Server
operation w/ LEDs

Prepare for
Installation of
SM Software

Install and Verify
SM SW on Host and

Workstation

* FC Planning and
Integration: User's Guide

and Svc Info

DS4000 Storage Manager
Concepts Guide

DS4000 Storage Exp Units
Install and User's Guides

DS4000 Fibre Channel
Storage Server

Installation Guides

Fibre Channel Cabling
Instructions

DS4000 and HBA Install
and User's Guides

DS4000 Storage Svr
Installation Guide

DS4000 RAID Controller
Enclosure Unit Install

and User's Guide

Copy Services
User's Guide

DS4000 Storage Manager

DS4000 Storage
Manager Installation

and Support
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DS4000 Hardware
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DS4000 Problem
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Make FC Connections

SET Link Speed
(1GB or 2GB)

Install Storage
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Install Storage
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Management
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* For pSeries Server and 6227 or 6228 HBA use only s
j0

0
1
0
4
6

  

 

   

DS4000 Storage Server publications 

The following tables present an overview of the DS4500, DS4400, DS4300 Fibre 

Channel, and DS4100 SATA Storage Server product libraries, as well as other 

related documents. Each table lists documents that are included in the libraries and 

what common tasks they address. Click on active links in the tables to access those 

documents currently available on the Internet. You can access documentation for 

the other DS4000 products at the following Web site: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

DS4500 Fibre Channel Storage Server library 

Table 1 on page xvii associates each document in the DS4500 Fibre Channel 

Storage Server library with its related common user tasks.

Figure  1. Installation  process  flow  by  current  publications
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Table 1. TotalStorage  DS4500  Fibre  Channel  Storage  Server  document  titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  TotalStorage  

DS4500  Installation  

and  Support  Guide, 

GC26-7530 

U U U 

IBM  TotalStorage  

DS4500  Fibre  

Channel  Cabling  

Instructions, 

24P8135 

U U 

IBM  TotalStorage  

DS4500  Storage  

Server  User’s  

Guide, GC26-7534 

U U  U 

IBM  TotalStorage  

DS4000  FC2-133  

Dual  Port  Host  Bus  

Adapter  Installation  

and  User’s  Guide, 

GC26-7532 

U U  

IBM  DS4000  

FC2-133  Host  Bus  

Adapter  Installation  

and  User’s  Guide, 

48P9823 

U U  

IBM  TotalStorage  

DS4500  Rack  

Mounting  

Instructions, 

19K0900 

U U 

IBM  Fibre  Channel  

Planning  and  

Integration:  User’s  

Guide  and  Service  

Information, 

SC23-4329 

U U U  U 

IBM  DS4000  

Management  Suite  

Java  User’s  Guide, 

32P0081 

U  U 

IBM  TotalStorage  

DS4000  Hardware  

Maintenance  

Manual,  GC26-7640 

U 

IBM  TotalStorage  

DS4000  Problem  

Determination  

Guide, GC26-7642 

U 
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf


DS4400 Fibre Channel Storage Server library 

Table 2 associates each document in the DS4400 Fibre Channel Storage Server 

library with its related common user tasks. 

 Table 2. TotalStorage  DS4400  Fibre  Channel  Storage  Server  document  titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  DS4400  Fibre  

Channel  Cabling  

Instructions, 

32P0343 

U U  

IBM  DS4400  Fibre  

Channel  Storage  

Server  User’s  

Guide, 32P0341 

U U U 

IBM  DS4000  

FC2-133  Dual  Port  

Host  Bus  Adapter  

Installation  and  

User’s  Guide, 

GC26-7532 

U  U 

IBM  TotalStorage  

DS4000  FC2-133  

Host  Bus  Adapter  

Installation  and  

User’s  Guide, 

48P9823 

U  U 

IBM  DS4000  

Management  Suite  

Java  User’s  Guide, 

32P0081 

U U 

IBM  TotalStorage  

DS4000  Hardware  

Maintenance  

Manual,  GC26-7640 

U 

IBM  TotalStorage  

DS4000  Problem  

Determination  

Guide, GC26-7642 

U 
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf


DS4300 Fibre Channel Storage Server library 

Table 3 associates each document in the DS4300 Fibre Channel Storage Server 

library with its related common user tasks.

 Table 3. TotalStorage  DS4300  Fibre  Channel  Storage  Server  document  titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  TotalStorage  

DS4300  Fibre  

Channel  Storage  

Server  Installation  

and  User’s  Guide, 

GC26-7531 

U U U 

IBM  TotalStorage  

DS4000  Hardware  

Maintenance  

Manual,  GC26-7640 

U 

IBM  TotalStorage  

DS4000  Problem  

Determination  

Guide, GC26-7642 

U 

IBM  TotalStorage  

DS4000  FC2-133  

Dual  Port  Host  Bus  

Adapter  Installation  

and  User’s  Guide,  

GC26-7532  

U U  

IBM  TotalStorage  

DS4300  Rack  

Mounting  

Instructions, 

24P8125 

U U 

IBM  TotalStorage  

DS4300  Fibre  

Channel  Cabling  

Instructions, 

24P8126 

U U 

  

DS4100 Storage Server library 

Table 4 associates each document in the DS4100 Storage Server library with its 

related common user tasks.

 Table 4. TotalStorage  DS4100  Storage  Server  document  titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  TotalStorage  

DS4100  Installation,  

User’s,  and  

Maintenance  Guide, 

GC26-7641 

U U U U 
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600rack.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/600cabling.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/fas1uig0.pdf


Table 4. TotalStorage  DS4100  Storage  Server  document  titles  by user  tasks  (continued)  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  TotalStorage  

DS4100  Cabling  

Guide,  24P8973 

U U  

IBM  TotalStorage  

DS4000  FC2-133  

Dual  Port  Host  Bus  

Adapter  Installation  

and  User’s  Guide, 

GC26-7532 

U  U 

IBM  DS4000  

FC2-133  Host  Bus  

Adapter  Installation  

and  User’s  Guide, 

48P9823 

U  U 

IBM  TotalStorage  

DS4000  Hardware  

Maintenance  

Manual,  GC26-7640 

U 

IBM  TotalStorage  

DS4000  Problem  

Determination  

Guide, GC26-7642 

U 
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7640-01.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26764202.pdf
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DS4000-related hardware publications 

Table 5 associates each of the following documents related to DS4000 operations 

with its related common user tasks. 

 Table 5. TotalStorage  DS4000-related  document  titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM Safety 

Information, 

P48P9741 

U  

IBM  TotalStorage  

DS4000  Quick  Start  

Guide,  GC26-7662 

U U 

IBM  TotalStorage  

DS4000  EXP100  

Storage  Expansion  

Unit  Release  Notes, 

GC26-7619 

U U 

IBM  TotalStorage  

DS4000  EXP100  

Storage  Expansion  

Unit  Installation  and  

Users  Guide, 

GC26-7601 

U U U U  U 

Fibre  Channel  

Solutions  - IBM  

DS4000  EXP500  

Installation  and  

User’s  Guide, 

59P5637 

U U U U  U 

IBM  TotalStorage  

DS4000  EXP700  

and  EXP710  

Storage  Expansion  

Units  Installation,  

User’s,  and  

Maintenance  Guide, 

GC26-7647 

U U U U  U 

IBM  TotalStorage  

DS4000  Hard  Drive  

and  Storage  

Expansion  

Enclosure  

Installation  and  

Migration  Guide, 

GC26-7639 

U U 

IBM  Netfinity® Fibre  

Channel  Cabling  

Instructions, 

19K0906 

U 

IBM  Fibre  Channel  

SAN  Configuration  

Setup  Guide, 

25P2509 

U U  U U  
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8851.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/exp1uig0.pdf
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ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/59p5637.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7647-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.software.ibm.com/pc/pccbbs/pc_servers_pdf/gc26-7663-00.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf


DS4000 Storage Manager Version 9 publications 

Table 6 associates each document in the DS4000 Storage Manager library with its 

related common user tasks. 

 Table 6. TotalStorage  DS4000  Storage  Manager  Version  9 titles  by user  tasks  

Title  User  Tasks 

Planning  Hardware  

Installation  

Software  

Installation  

Configuration  Operation  and  

Administration  

Diagnosis  and  

Maintenance  

IBM  TotalStorage  

DS4000  Storage  

Manager  Version  9 

Installation  and  

Support  Guide  for  

Windows  

2000/Server  2003,  

NetWare,  ESX  

Server,  and  Linux,  

GC26-7649 

U U U 

IBM  TotalStorage  

DS4000  Storage  

Manager  Version  9 

Installation  and  

Support  Guide  for  

AIX,  UNIX,  Solaris  

and  Linux  on Power,  

GC26-7648  

U U U 

IBM  TotalStorage  

DS4000  Storage  

Manager  Version  9 

Copy  Services  

User’s  Guide, 

GC26-7660 

U U U U 

IBM TotalStorage 

DS4000 Storage 

Manager Version 9 

Concepts Guide, 

GC26-7661 

U U  U U U U

  

How to send your comments 

Your feedback is important to help us provide the highest quality of information. If 

you have any comments about this document, please either fill out the Readers’ 

comments form (RCF) at the back of this document and give it to an IBM 

representative, or submit it in one of the following ways: 

v   E-mail 

–   Submit your comments over the Internet to: 

starpubs@us.ibm.com

–   Submit your comments over IBMLink™ from the U.S.A. to: 

STARPUBS at SJEVM5

–   Submit your comments over IBMLink from Canada to: 

STARPUBS at TORIBM

–   Submit your comments over IBM Mail Exchange to: 
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Chapter  1.  Introduction  

Scalability is a primary attribute of the IBM TotalStorage DS4000 Storage Server 

family. Whenever the need arises, you can expand a DS4000 Storage Server from 

its minimum to its maximum capacity configuration. To expand DS4000 Storage 

Server configurations you can purchase additional equipment or migrate equipment 

from DS4000 Storage Server configurations previously deployed. 

The typical DS4000 Storage Server drive connects to both Controller A and 

Controller B. Taken together, these connections represent a dual drive loop or a 

redundant drive loop pair. You must connect drive loops in pairs to enable 

redundant drive loop configurations (two data paths per drive enclosure). 

Table 7 provides a list of the maximum allowable number of drives and drive loop 

pairs for each DS4000 Storage Server by machine type and model number. It also 

specifies storage expansion enclosure license requirements. 

 

 

Important:  

Do not intermix fibre channel and SATA devices (DS4100 and EXP100) in the 

same storage subsystem environment.

  Table 7. Maximum  allowable  drives  and  drive  loop  pairs  in DS4000  storage  servers  

Product  name  

Machine  

type  

Model  

number  

Maximum  

number  of 

drives  

Maximum  

number  of 

drive  loop  

pairs  

License  

requirement  to 

add  storage  

expansion  

units  

IBM TotalStorage 

DS4100 Storage 

Server 

1724 100 56 1 None 

IBM TotalStorage 

FAStT200 Fibre 

Channel Storage 

Server 

3542 1RU
1RX 

38 1 None 

IBM TotalStorage 

FAStT200 High 

Availability (HA) 

Fibre Channel 

Storage Server 

2RU
2RX 

66 1 None 

IBM TotalStorage 

FAStT500 Fibre 

Channel Storage 

Server 

3552 1RU
1RX 

224 2 None 
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Table 7. Maximum  allowable  drives  and  drive  loop  pairs  in DS4000  storage  

servers  (continued)  

Product  name  

Machine  

type  

Model  

number  

Maximum  

number  of  

drives  

Maximum  

number  of 

drive  loop  

pairs  

License  

requirement  to 

add  storage  

expansion  

units  

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Server 

1722 60X 

60U 

56 1 Purchase 

storage 

expansion unit 

entitlements in 

increments up to 

three storage 

expansion units 

per DS4300 

Storage Server. 

IBM TotalStorage 

DS4300 Turbo Fibre 

Channel Storage 

Server 

112 1 None. The 

DS4300 Turbo 

option includes 

a seven storage 

expansion unit 

entitlement. 

IBM TotalStorage 

DS4300 Single 

Controller Fibre 

Channel Storage 

Server 

6LU
6LX 

14 0 None. The 

DS4300 Single 

Controller 

Storage Server 

does not 

support storage 

expansion 

enclosure 

attachment. 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server 

1742 1RU
1RX 

224 2 None 

IBM TotalStorage 

DS4500 Fibre 

Channel Storage 

Server 

1742 90X 

90U 

224 2 None

  

Notes:   

1.   The maximum number of drives supported by the FAStT200 HA Storage Server 

(models 2RU and 2RX) assumes attachment to 4 14-drive storage expansion 

enclosures containing 56 fibre channel drives. 

2.   The maximum number of drives supported by FAStT500, DS4400, and DS4500 

storage servers assumes their attachment to 16 14-drive storage expansion 

enclosures.

Intermixing Enclosures 

For hardware compatibility, ensure that the environmental service module (ESM) 

firmware for each storage expansion enclosure and the storage server controller 

firmware are either at or above the levels that are recommended in Table 16 on 

page 24 and Table 17 on page 26. 

 

 

2 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



You can mix DS4000 TotalStorage EXP500 (which operates only at 1 Gbps) and 

DS4000 TotalStorage EXP700 (which operates at either 1 Gbps or 2 Gbps) storage 

expansion enclosures in the same redundant drive loop pair in all DS4000 Storage 

Server configurations with one exception. You cannot mix these enclosures in the 

same redundant drive loop pair in DS4300 Storage Server configurations. The 

DS4300 Storage Server (models 60X and 60U) supports only DS4000 EXP700 and 

DS4000 EXP710 (which operates only at 2 Gbps) storage expansion enclosures. 

There is no restriction to the physical sequence of mixed EXP700 and EXP500 

expansion units in the same redundant drive loop pair. See “Intermixing EXP700 

and EXP710 storage expansion enclosures” on page 6 additional information. 

Although the EXP700 storage expansion enclosure is capable of operating at 2 

Gbps, you must set the fibre channel speed of drive loops in a mixed storage 

expansion enclosure environment to the lowest fibre channel speed supported by all 

hardware in the loop, which is 1 Gbps. If one of the drive loops in a DS4000 

storage configuration is set to 1 Gbps, you must set all of the drives’ loops to 1 

Gbps. This speed restriction applies to all four drive loops in either the DS4400 or 

DS4500 storage subsystem configuration, even where some of the drive loops 

consist only of EXP700 storage expansion enclosures that might otherwise operate 

at 2 Gbps. Although you can mix DS4000 TotalStorage EXP700 and DS4000 

TotalStorage EXP710 storage expansion enclosures in the same redundant drive 

loop pair in any DS4000 Storage Server configuration, you cannot intermix the 

sequence of these enclosure models in a drive loop. See “Intermixing EXP700 and 

EXP710 storage expansion enclosures” on page 6 additional information. 

Do not mix DS4000 TotalStorage EXP500 (which operates only at 1 Gbps) and 

DS4000 TotalStorage EXP710 (which operates only at 2 Gbps) storage expansion 

enclosures in the same redundant drive loop pair. Also, do not attach these storage 

expansion enclosures to the same controller. 

Do not intermix DS4000 TotalStorage EXP100 storage expansion enclosures with 

any other storage expansion enclosure model in the same redundant drive loop 

pair. 

You can intermix DS4000 EXP700s and DS4000 EXP710s in the same drive loop, 

but all DS4000 EXP710s in the redundant drive loop must be grouped together. 

Important:  Even though IBM supports intermixing different drive expansion 

enclosure models in the same redundant drive loop, we recommend use of a single 

drive expansion enclosure model in given redundant drive loop. This is the best 

practice. 

Table 8 indicates what DS4000 expansion enclosures may coexist in the same 

redundant drive loop of a DS4000 storage subsystem by model. 

 Table 8. Mixed  DS4000  expansion  enclosure  compatibility  in storage  subsystems  by model  

DS4000  expansion  

enclosure  

DS4000  

EXP100  

(SATA) 

DS4000  

EXP500  (Fibre 

Channel) 

DS4000  

EXP700  (Fibre 

Channel) 

DS4000  

EXP710  (Fibre 

Channel) 

IBM  TotalStorage  

DS4000  EXP100  

(SATA) 

U 

IBM  TotalStorage  

DS4000  EXP500  (Fibre 

Channel) 

U 

(1 Gbps only) 

U 

(1 Gbps only) 

 

 

Chapter 1. Introduction 3



Table 8. Mixed  DS4000  expansion  enclosure  compatibility  in storage  subsystems  by 

model  (continued)  

IBM  TotalStorage  

DS4000  EXP700(Fibre 

Channel) 

U 

(1 Gbps only) 

U U 

IBM  TotalStorage  

DS4000  EXP710  (Fibre 

Channel) 

U U

  

Table 9 indicates what DS4000 expansion enclosures may attach to DS4000 

storage servers by model. 

 Table 9. DS4000  expansion  enclosure  compatibility  with  DS4000  storage  servers  by  model  

DS4000  storage  

device  

DS4000  

EXP100  

(SATA) 

DS4000  

EXP500  (Fibre 

Channel) 

DS4000  

EXP700  (Fibre 

Channel) 

DS4000  

EXP710  (Fibre 

Channel) 

DS4100  Storage  

Server  (SATA) 

U  

FAStT200  Storage  

Server  (Fibre Channel) 

U 

(1 Gbps only) 

U 

(1 Gbps only) 

FAStT500  Storage  

Server  (Fibre Channel) 

U 

(1 Gbps only) 

U 

(1 Gbps only) 

FAStT500  Storage  

Server  (Fibre Channel) 

U 

DS4300  Storage  

Server  (Single 

Controller, Fibre 

Channel) 

DS4300  Turbo 

Storage  Server  (Fibre 

Channel) 

U�1��2�  U U 

DS4400  Storage  

Server  (Fibre Channel) 

U�2�  U 

(1 Gbps only) 

U U 

DS4500  Storage  

Server  (Fibre Channel) 

U�2�  U 

(1 Gbps only) 

U U

  

�1�  While the DS4300 Turbo Storage Server will support fibre channel or SATA 

drives, it will not support both in a mixed environment. It will support SATA drives 

only in an attached storage enclosure, never in the DS4300 Turbo Storage Server. 

�2�  DS4000 storage servers require the following firmware to manage EXP100 

expansion enclosures. 

DS4300  Turbo  and  DS4500  

05.41.5x.xx or 06.10.xx.xx (recommended) 

DS4400  

06.10.xx.xx

Important:  Do not change the speed of a drive loop while the DS4000 Storage 

Server is powered on. Such a speed change will cause unpredictable results. To 

change the speed of a drive loop: 

__ Step 1.   Prepare applications for DS4000 Storage Server shutdown. 
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__ Step 2.   Shutdown the DS4000 Storage Server. 

__ Step 3.   Shutdown the DS4000 storage expansion enclosures. 

__ Step 4.   Change the fibre channel speed settings. 

__ Step 5.   Power on the DS4000 storage expansion enclosures. 

__ Step 6.   Power on the DS4000 Storage Server. 

__ Step 7.   Restore DS4000 Storage Server host application operations.

Note:   For additional information on turning a storage server on and off, see the 

appropriate DS4000  Storage  Server  installation  and  user’s  guide. For more 

information on these guides, see the following Web site: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

Intermixing EXP500 and EXP700 storage expansion enclosures 

Figure 2 illustrates cabling of DS4000 TotalStorage EXP500 and EXP700 storage 

expansion enclosures in a mixed configuration.
 

There are maximum limits to the number of fibre channel hard drives that you can 

configure in redundant drive loop pairs. Table 10 on page 6 lists the numbers of 

EXP500 and EXP700 storage expansion enclosures that you can combine for use 

in a single redundant drive loop pair. Table 10 on page 6 assumes that a DS4000 

EXP700

EXP700

EXP500

Minihub speed
must be set to
1Gbps for all

four drive
minihubs

Drive loop
A

Drive loop
B

EXP500 and
EXP700 drive
enclosures are

in the same
drive loop

m
ig

0
0
0
0
1

  

Figure  2. DS4000  EXP500  and  EXP700  cabling  in a mixed  configuration
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Storage Server is generally capable of addressing the maximum of 112 fibre 

channel hard drives for each redundant drive loop pair. 

Important:  IBM supports only those EXP500 and EXP700 Storage Expansion Unit 

combinations listed in Table 10. 

 Table 10.  Supported  EXP500  and  EXP700  combinations  per  maximum  redundant  drive  loop  

pair  drives  

Total number  of 

EXP500  enclosures  

per  redundant  drive  

loop  pair  

Total number  of 

EXP700  

enclosures  per  

redundant  drive  

loop  pair  

Maximum  number  of 

storage  expansion  

units  per  redundant  

drive  loop  pair  

Maximum  number  

of drives  per  

redundant  drive  

loop  pair  

11 0 11 110 

10 0 10 100 

9 1 10 104 

8 2 10 108 

7 3 10 112 

6 3 9 102 

5 4 9 106 

4 5 9 110 

3 6 9 114 

2 6 8 104 

1 7 8 108 

0 8 8 112
  

Note:   The combination of three EXP500 and six EXP700 storage expansion 

enclosures has the maximum number of 114 drives per redundant drive loop 

pair. You can have this maximum number of hard drives per drive loop pair 

only in this mixed EXP500 and EXP700 configuration. 

Intermixing EXP700 and EXP710 storage expansion enclosures 

It is possible to intermix EXP700 and EXP710 storage expansion enclosures in the 

same drive loop. To do so, however, you must group all of the EXP710 storage 

expansion enclosures together. Figure 3 on page 8 though Figure 4 on page 9 

illustrate two acceptable EXP700 and EXP710 intermixing cabling configurations in 

which all EXP710 storage expansion enclosures are grouped together. Figure 5 on 

page 10 shows an acceptable configuration that is not recommended because it 

may later present cabling problems when you may choose to add new EXP710 

drive enclosures to a redundant drive loop that is already configured. Figure 6 on 

page 11 and Figure 7 on page 12 show two unacceptable intermixed configurations 

in which all EXP710 storage expansion enclosures are not grouped together. 

These intermixing requirements must also be met if you are upgrading some (but 

not all) of the EXP700 storage expansion enclosures in a drive loop with the 

EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kit (P/N 25R0166). 
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Important:  

Failure to follow these intermixing requirements for drive loops that include 

both EXP700 and EXP710 storage expansion enclosures may result in drive 

loop performance degradation that could cause loss of data access and 

possibly loss of data.

 Figure 3 on page 8 though Figure 5 on page 10 show three acceptable EXP700 

and EXP710 intermixing cabling configurations in which all EXP710 storage 

expansion enclosures are grouped together. Note that in Figure 5 on page 10, the 

EXP710 storage expansion enclosures are grouped together, even though the 

EXP700 storage expansion enclosures are not grouped together. 

Although illustrations Figure 3 on page 8 through Figure 7 on page 12 incorporate 

the DS4000 DS4300 Storage Server for the sake of example, other DS4000 

storage servers may be acceptable replacements. 
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Figure  3. Acceptable  intermixed  EXP700  and  EXP710  loop  configuration  (1 of 3)
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Figure  4. Acceptable  intermixed  EXP700  and  EXP710  loop  configuration  (2 of 3)
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In Figure 6 on page 11 and Figure 7 on page 12, the intermixed configurations 

shown are unacceptable because the EXP710 storage expansion enclosures in the 

redundant drive loop are not grouped together.
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h
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EXP700

EXP710

EXP710

EXP700

  

Figure  5. Acceptable  (not  recommended)  intermixed  EXP700  and  EXP710  loop  configuration  

(3 of 3)
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EXP710
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EXP710

Figure  6. Unacceptable  intermixed  EXP700  and  EXP710  loop  configuration  (1 of 2)
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Storage subsystem loop schemes 

Although a variety of cable loop schemes may function acceptably, IBM 

recommends consistent use of only one such scheme when connecting DS4000 

storage servers and expansion enclosures. Figure 8 on page 13 illustrates the only 

cable loop scheme that IBM recommends when connecting DS4000 storage servers 

and expansion enclosures.
 

d
s
h
0
0
0
1
7

EXP710

EXP700

EXP710

EXP700

  

Figure  7. Unacceptable  intermixed  EXP700  and  EXP710  loop  configuration  (2 of 2)
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Legend:  

�1�  Integrated drive/controller DS4000 storage subsystem (for example, 

DS4300 or DS4100) 

�2�  Controller only DS4000 storage subsystem (for example, DS4400 or 

DS4500)

IBM recommends against inconsistent use of any cable loop scheme. IBM also 

recommends against the use of cable loop schemes illustrated in Figure 9 on page 

14 through Figure 12 on page 17 when connecting DS4000 storage servers and 

expansion enclosures because they are not standardized for IBM DS4000 Support.
 

d
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8

1 2

  

Figure  8. Cable  loop  scheme  advised  when  connecting  DS4000  storage  subsystems
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Legend:  

�1�  Integrated drive/controller DS4000 storage subsystem (for example, 

DS4300 or DS4100) 

�2�  Controller only DS4000 storage subsystem (for example, DS4400 or 

DS4500)

 

d
s
h

0
0

0
1
1

1 2

  

Figure  9. Alternate  cable  loop  schemes  possible  but not  recommended  when  connecting  

DS4000  storage  subsystems  (1 of 4)
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Legend:  

�1�  Integrated drive/controller DS4000 storage subsystem (for example, 

DS4300 or DS4100) 

�2�  Controller only DS4000 storage subsystem (for example, DS4400 or 

DS4500)

 

d
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h
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9

1 2

  

Figure  10.  Alternate  cable  loop  schemes  possible  but  not  recommended  when  connecting  

DS4000  storage  subsystems  (2 of 4)
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Legend:  

�1�  Integrated drive/controller DS4000 storage subsystem (for example, 

DS4300 or DS4100) 

�2�  Controller only DS4000 storage subsystem (for example, DS4400 or 

DS4500)
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Figure  11. Alternate  cable  loop  schemes  possible  but not  recommended  when  connecting  

DS4000  storage  subsystems  (3 of 4)
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Legend:  

�1�  Integrated drive/controller DS4000 storage subsystem (for example, 

DS4300 or DS4100) 

�2�  Controller only DS4000 storage subsystem (for example, DS4400 or 

DS4500)

Enclosure IDs 

Each drive enclosure in a DS4000 storage subsystem drive loop must have a 

unique drive enclosure ID. DS4000 controllers use a combination of the enclosure 

ID and the number of the physical slot that a hard drive occupies to create a unique 

loop address or arbitrated loop physical address (AL_PA) for each drive in a drive 

loop. The enclosure ID consists of two digits, a tens (x10) digit and a ones (x1) 

digit. The possible values for the tens and the ones digits are 0-9 for FAStT500 

drive enclosures, and 0-7 for DS4400 drive enclosures. 

Give each drive expansion enclosure in a redundant drive loop a unique ones digit 

ID. This setting will enforce hard AL_PAs (unchangeable between Loop 

Initializations [LIPs]) for the drives and facilitate drive loop problem troubleshooting 

in the event of an error. If the ones digits are not unique, two or more devices will 

have the same hard AL_PA. In such a case, the controller will use soft AL_PAs for 

the devices that have identical hard AL_PAs. 

The problem with soft addressing is that addresses may change between LIPs. This 

possibility increases the difficulty of troubleshooting drive loop problems because it 

is difficult to ascertain whether the same device with a different address or a 

different device may be causing a problem. Since the DS4000 storage server 

supports more enclosures than available values of the enclosure ID ones digit, 

Table 11 on page 18 through Table 15 on page 20 suggest enclosure ID settings for 

various drive expansion enclosure families to minimize soft addressing in a drive 

loop. 

d
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Figure  12.  Alternate  cable  loop  schemes  possible  but  not  recommended  when  connecting  

DS4000  storage  subsystems  (4 of 4)
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Table 11. EXP500  Storage  Expansion  Enclosure  ID settings  

Storage  expansion  

enclosure  

Enclosure  ID setting  for  

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  if 

applicable/supported  

1st unit 

(storage expansion enclosure 

or storage server with internal 

drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP500) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP500) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP500) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP500) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP500) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP500) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP500) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP500) 

08 x8 

(where x is 2-7) 

10th unit 

(EXP500) 

09 x9 

(where x is 2-7) 

11th unit 

(EXP500) 

10 x0 

(where x is 3-7)
  

Note:   Drives in the 11th enclosures of each drive loop in Table 11 will have soft 

AL_PAs. 

Table 12 suggests enclosure ID settings that minimize soft addressing for EXP100 

storage expansion enclosures in a drive loop. 

 Table 12.  EXP100  Storage  Expansion  Enclosure  ID settings  

Storage  expansion  

enclosure  (unmixed)  

Enclosure  ID setting  for  

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  if 

applicable/supported  

1st unit 

(EXP100 Expansion 

Enclosure or DS4000 Storage 

Server with internal drive 

slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP100) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP100) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP100) 

03 x3 

(where x is 2-7) 
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Table 12. EXP100  Storage  Expansion  Enclosure  ID settings  (continued)  

Storage  expansion  

enclosure  (unmixed)  

Enclosure  ID setting  for 

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  if 

applicable/supported  

5th unit 

(EXP100) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP100) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP100) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP100) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP100, where the first unit 

is a DS4300 only) 

11 

  

Note:   All drives in drive loops described in Table 12 on page 18 will be assigned 

hard AL_PAs. 

Table 13 suggests enclosure ID settings that minimize soft addressing for EXP700 

or EXP710 storage expansion enclosures in a drive loop. 

 Table 13. EXP700  or EXP710  Storage  Expansion  Enclosure  ID settings  

Storage  expansion  

enclosure  (unmixed)  

Enclosure  ID setting  for 

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  if 

applicable/supported  

1st unit 

(storage expansion enclosure 

or DS4000 Storage Server 

with internal drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP700) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP700) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP700) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP700) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP700) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP700) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP700) 

07 x7 

(where x is 2-7)
  

Note:   All drives in drive loops described in Table 13 will be assigned hard AL_PAs. 

Table 14 on page 20 suggests enclosure ID settings that minimize soft addressing 

for the EXP500 and EXP700 Storage Expansion Enclosure when intermixed in a 
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redundant drive loop. 

 Table 14.  Intermixed  EXP500  and  EXP700  Storage  Expansion  Enclosure  ID settings  

Storage  expansion  

enclosure  models  

(intermixed)  

Enclosure  ID setting  for  

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  

1st unit 

(storage expansion enclosure 

or DS4000 Storage Server 

with internal drive slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP500 or EXP700) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP500 or EXP700) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP500 or EXP700) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP500 or EXP700) 

04 x4 

(where x is 2-7) 

6th unit 

(EXP500 or EXP700) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP500 or EXP700) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP500 or EXP700) 

07 x7 

(where x is 2-7) 

9th unit 

(EXP500 or EXP700) 

10 x0 

(where x is 2-7) 

10th unit 

(EXP500 or EXP700) 

11 x1 

(where x is 2-7)
  

Note:   The drives in the 9th and 10th enclosures in each drive loop described in 

Table 14 will have soft AL_PAs. 

Table 15 suggests enclosure ID settings that minimize soft addressing for the 

EXP700 and EXP710 Storage Expansion Enclosure when intermixed in a redundant 

drive loop. 

 Table 15.  Intermixed  EXP700  and  EXP710  Storage  Expansion  Enclosure  ID settings  

Storage  expansion  

enclosure  models  

(intermixed)  

Enclosure  ID setting  for  

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  

1st unit 

(storage expansion enclosure 

or DS4000 Storage Server 

with internal slots) 

00 x0 

(where x is 2-7) 

2nd unit 

(EXP700 or EXP710) 

01 x1 

(where x is 2-7) 

3rd unit 

(EXP700 or EXP710) 

02 x2 

(where x is 2-7) 

4th unit 

(EXP700 or EXP710) 

03 x3 

(where x is 2-7) 

5th unit 

(EXP700 or EXP710) 

04 x4 

(where x is 2-7) 
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Table 15. Intermixed  EXP700  and  EXP710  Storage  Expansion  Enclosure  ID 

settings  (continued)  

Storage  expansion  

enclosure  models  

(intermixed)  

Enclosure  ID setting  for 

enclosure  in the  first  

redundant  drive  loop  

Enclosure  ID setting  for 

enclosure  in the  second  

redundant  drive  loop  

6th unit 

(EXP700 or EXP710) 

05 x5 

(where x is 2-7) 

7th unit 

(EXP700 or EXP710) 

06 x6 

(where x is 2-7) 

8th unit 

(EXP700 or EXP710) 

07 x7 

(where x is 2-7)
  

Note:   The drives in the 9th and 10th enclosures in each drive loop described in 

Table 15 on page 20 will have soft AL_PAs. 

DS4000 Storage Manager installation and support guides 

This publication frequently cites IBM  TotalStorage  DS4000  Storage  Manager  

installation  and  support  guides  supporting various versions and operating system 

environments. There are currently two, namely: 

v   IBM  TotalStorage  DS4000  Storage  Manager  Installation  and  Support  Guide  for  

AIX,  HP-UX,  Solaris  and  Linux  on  Power  

v   IBM  TotalStorage  DS4000  Storage  Manager  Installation  and  Support  Guide  for  

Intel-based  Operating  System  Environments

Visit the following Web site to access documentation related to your particular 

operating system and DS4000 Storage Manager version. 

www-1.ibm.com/servers/storage/support/fastt/index.html 

See “DS4000 Storage Server publications” on page xvi for more information. 
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Chapter  2.  Prerequisites  to adding  capacity  and  hard  drive  

migration  

Perform the preliminary steps detailed in this chapter before you add storage 

capacity or migrate hard drives. After you meet these prerequisite requirements, 

proceed to any of the following sections to address your particular storage hardware 

addition or migration requirements: 

v   Chapter 3, “Adding one or more new hard drives,” on page 31 

v   Chapter 4, “Adding expansion units containing new hard drives,” on page 37 

v   Chapter 5, “Migrating one or more hard drives,” on page 47 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 55 

v   Chapter 7, “Upgrading a storage server in a functioning configuration,” on page 

63

Failure to perform the steps listed in this section might result in loss of data 

availability, and in some cases, loss of data. Perform the following steps on the 

DS4000 Storage Server to which you will migrate or add new hard drives: 

__ Step 1.   Complete a full backup of all data residing on the DS4000 Storage 

Server. 

__ Step 2.   Verify that the backup was successful. 

__ Step 3.   Verify that the DS4000 Storage Server has the latest controller 

firmware, non-volatile storage random access memory (NVSRAM), and 

ESM firmware. 

Note:   If your DS4000 Storage Server has controller firmware version 

04.01.02.29 or lower, download and install controller firmware 

version 4.01.02.33 or higher before you download and install 

controller firmware version 5.30.xx.xx or higher. 

__ Step 4.   Verify that the drive firmware is at the latest level. If it is not, see 

“Upgrading drive firmware levels” on page 26. 

__ Step 5.   Verify that the DS4000 Storage Server to which you will migrate the 

hard drives is in optimal  state. If it is not, perform the appropriate steps 

listed in the Recovery Guru to bring the storage server into optimal  

state. 

__ Step 6.   Use the Read_Link_Status  function of the Storage Manager client 

program and the DS4000 Storage Server management event log (MEL) 

to verify that the drive loops are in optimal  state. If the DS4000 storage 

subsystem controller firmware is version 06.10.xx.xx or higher, use the 

drive channel diagnostics to determine if the drive loop is optimal. 

__ Step 7.   Investigate and resolve any errors that reported in the DS4000 Storage 

Server MEL. 

__ Step 8.   Save and store the storage subsystem profile of the DS4000 Storage 

Server.

Important:  Do not store DS4000 Storage Server profiles in the same location as 

the logical drives defined on your DS4000 Storage Server. Should you do so, and a 

RAID array failure occurs during subsequent migration, the data will be lost. 
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If you are migrating drives from another DS4000 Storage Server, you must also 

perform the preceding steps 1 on page 23 through 8 on page 23 on the DS4000 

Storage Server from which you intend to migrate hard drives. You must also 

perform the following steps to flush server-cached I/O to disks. 

__ Step 1.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. 

__ Step 2.   Verify that there are no programs, services, or processes running in the 

background that might write data to the logical drives. (For example, 

Microsoft® MSCS service periodically writes to the “Quorum” disk.) 

__ Step 3.   Unmount the file systems to flush I/O from the server cache to disk. 

Notes:   

a.   In a Microsoft Windows® environment, it is also necessary for you to 

remove the drive letter or the mount points of the mapped LUNs 

instead of unmounting the file systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the unmount procedure.

After you meet prerequisites described in this section, proceed to any of the 

following sections to address your particular drive migration requirements. 

v   Chapter 3, “Adding one or more new hard drives,” on page 31 

v   Chapter 4, “Adding expansion units containing new hard drives,” on page 37 

v   Chapter 5, “Migrating one or more hard drives,” on page 47 

v   Chapter 6, “Migrating expansion units containing hard drives,” on page 55 

v   Chapter 7, “Upgrading a storage server in a functioning configuration,” on page 

63

Verifying ESM firmware and NVSRAM file levels 

The controller firmware and NVSRAM of the DS4000 Storage Server to which you 

will migrate hard drives, and the ESM firmware in the DS4000 storage expansion 

enclosures must be at the levels indicated in Table 16 to ensure firmware 

compatibility between the migrating and original hardware. Additionally, DS4000 

Storage Manager version 8.3 or higher client software, in conjunction with the 

controller firmware level 5.30.xx.xx or higher, allows you to upgrade the ESM 

firmware while the storage server receives I/O from the host server. 

Tip:  Even though you can upgrade the DS4000 Storage Server and ESM firmware 

while it processes I/O from the host server, schedule upgrades to occur during time 

periods of low I/O between the DS4000 storage servers and host servers. 

Table 16 lists IBM DS4000 machine types and model numbers, as well as their 

current firmware (AppWare or BootWare) and NVSRAM versions. 

 Table 16.  Compatible  controller  firmware  and  NVSRAM  version  by machine  type  and  model  

number  

Product  

name/model  

Machine  

type  

Model  

number  

Firmware  version  

(AppWare  / 

BootWare)  NVSRAM  version  

IBM TotalStorage 

DS4100 Storage 

Server 

1724 100 05.42.xx.xx N1724F100R842V07 
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Table 16. Compatible  controller  firmware  and  NVSRAM  version  by machine  type  and  model  

number  (continued)  

Product  

name/model  

Machine  

type  

Model  

number  

Firmware  version  

(AppWare  / 

BootWare)  NVSRAM  version  

IBM TotalStorage 

FAStT200 Fibre 

Channel Storage 

Server 

3542 1RU 

1RX 

05.30.16.00 N3542-1RUR830V09 

IBM TotalStorage 

FAStT200 HA Fibre 

Channel Storage 

Server 

2RU
2RX 

05.30.16.00 N3542-2RUR830V12 

IBM TotalStorage 

FAStT500 Fibre 

Channel Storage 

Server 

3552 1RU 

1RX 

05.30.16.00 N3552F500R830V05 

IBM TotalStorage 

DS4300 Fibre 

Channel Storage 

Server 

1722 60X 

60U 

05.34.02.00 N1722F600R834V01 

IBM TotalStorage 

DS4300 Turbo Fibre 

Channel Storage 

Server 

06.10.06.00
06100100 

N1722F600R910V03 

IBM TotalStorage 

DS4300 Single 

Controller Fibre 

Channel Storage 

Server 

6LU 

6LX 

05.34.02.00 N1722F60LR834V0 

IBM TotalStorage 

DS4400 Fibre 

Channel Storage 

Server 

1742 1RU 

1RX 

06.10.06.00
06100100 

N1742F700R910V02 

IBM TotalStorage 

DS4500 Fibre 

Channel Storage 

Server 

1742 90X 

90U 

06.10.06.00
06100100 

N1742F900R910V02

  

Note:   Visit the following Web site either to verify software version levels or to 

identify possible interim updates to firmware and NVSRAM file versions 

described in Table 16 on page 24. 

www-1.ibm.com/servers/storage/support/fastt/index.html 

 Update the DS4000 controller firmware and NVSRAM to the levels indicated in 

Table 16 on page 24 (or higher) before you upgrade the ESM firmware on the 

storage expansion enclosures to versions indicated in Table 17 on page 26. 

Table 17 on page 26 lists IBM DS4000 storage expansion enclosure models by 

name, machine type, model number, and current ESM firmware version. 

 

 

Chapter 2. Prerequisites to adding capacity and hard drive migration 25

http://www-1.ibm.com/servers/storage/support/fastt/index.html


Table 17.  Compatible  expansion  unit  ESM  firmware  version  by machine  type  and  model  

number  

DS4000  Storage  Expansion  Unit  

product  name/model  

Machine  

type  

Model  

number  

ESM  firmware  

version  

IBM TotalStorage DS4000 EXP100 1710 10U 9554 

IBM TotalStorage DS4000 EXP500 3560 1RU
1RX 

9166 

IBM TotalStorage DS4000 EXP700 1740 1RU
1RX 

9326 

IBM TotalStorage DS4000 EXP710 1740 710 9627
  

Perform the following steps to upgrade ESM firmware for a down-level controller: 

__ Step 1.   Upgrade the DS4000 Storage Manager software to the latest version. 

That is DS4000 Storage Manager version 9.1x. For additional 

information, see the IBM  TotalStorage  DS4000  Storage  Manager  

installation  and  support  guide  for the appropriate server operating 

system environment at: 

www-1.ibm.com/servers/storage/support/fastt/index.html

Note:   To ensure the highest level of software compatibility, update the 

host server’s multi-path software (Redundant Disk Array 

Controller [RDAC], IBMSAN.CDM, or Linux failover adapter 

driver) to the level that is either supported by or released with 

the controller firmware that you intend to download. See the 

following Web site for current details on software compatibility: 

www-1.ibm.com/support/docview.wss?uid=psg1MIGR-50176 

__ Step 2.   Upgrade the controller firmware and NVSRAM. See Table 16 on page 

24 and the web site listed earlier in conjunction with step1. 

Note:   See the readme file in the DS4000 Storage Manager controller 

firmware package associated with the appropriate host operating 

system environment for a support statement about the 

concurrent controller firmware download (that is, downloading 

code to the DS4000 Storage Server while it is processing I/O 

from the host server). 

__ Step 3.   Upgrade the storage expansion enclosure ESM firmware. With DS4000 

Storage Manager version 8.3 or higher and controller firmware version 

05.3x.xx.xx or higher, you can update the ESM firmware while the 

DS4000 Storage Server is processing I/O from the host server. 

Important:  Even though the DS4000 Storage Server supports controller 

and ESM firmware upgrade while the DS4000 Storage Server 

processes I/O from the host server, schedule controller and ESM 

firmware upgrades to occur during time periods of low I/O between the 

DS4000 storage servers and host servers.

Upgrading drive firmware levels 

Before you begin migration, upgrade the drive firmware to the latest level. Do not 

move or migrate fibre channel drives from a 1 Gbps fibre channel environment to a 

2 Gbps fibre channel environment unless you have installed the latest firmware 

documented to enable their operation in a 2 Gbps fibre channel environment. 
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Downloading drive firmware 

This section provides instructions for downloading DS4000 drive firmware. See the 

online help for additional information. 

Important:  

1.   IBM supports firmware download with I/O, sometimes referred to as ″concurrent 

firmware download″. This feature is not supported for drive firmware. 

2.   Before starting the drive firmware download process: 

v   Stop all I/O activity before downloading drive firmware to a DS4000 Storage 

Server. 

v   Unmount the file systems on all logical drives accessing the drives that you 

select for firmware upgrade. 

v   Complete a full backup of all data residing on the drives that you select for 

firmware upgrade.

Downloading Storage Manager version 9.10 drive firmware 

To download drive firmware for DS4000 Storage Manager version 9.10, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   On the Enterprise Management window’s menu bar, click Tools  → Manage  

Device. The Subsystem Management window opens. 

 3.   On the Subsystem Management window’s menu bar, click Advanced  → 

Maintenance  → Download  → Drive  Firmware/Mode  pages  .... The Download 

Drive Firmware wizard window opens to the Introduction page. Read the 

instructions displayed and click Next.

Note:   Storage Manager version 9.10 offers you the option to download and 

update up to four different firmware file types simultaneously. Previous 

Storage Manager versions did not offer this capability. 

 4.   Click Browse  to locate the server directory that contains the firmware that you 

plan to download. 

 5.   Select the firmware file that you plan to download and click OK. The file 

appears listed in the ″Selected Packages″ window pane. 

 6.   Select the firmware file for any additional drive types that you intend to 

download and click OK. Additional files appear listed in the ″Selected 

Packages″ window pane. A maximum total of four drive types are possible. 

 7.   Click Browse  to repeat step 6 until you have selected each firmware file that 

you plan to download. 

 8.   When you have finished specifying the firmware packages for download, select 

Next. 

 9.   The Select Drive window opens, containing two tabs, a Compatible  Drives  tab 

and an Incompatible  Drives  tab. The Compatible  Drives  tab contains a list 

of the drives compatible to the firmware package types that you selected. From 

that list, select the drives to which you plan to download the drive firmware that 

you selected in steps 6 and 7. 

Note:   The firmware that you propose to download should be listed on the 

Compatible  Drives  tab. If your particular drives’ product ID matches 

the firmware type, however, and it is not listed as compatible on the tab, 

contact your IBM technical support representative for additional 

instructions. 

10.   Select the Compatible  Drives  tab. 
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Press and hold the Ctrl  key while using your mouse to select multiple drives 

individually, or press and hold the shift  key while using your mouse to select 

multiple drives listed in series. The compatible firmware that you selected in 

steps 5 on page 27 and 6 on page 27 will download to the drives that you 

select. 

11.   Click Finish  to initiate download of the drive firmware to each compatible drive 

that you selected in step 9 on page 27. 

12.   The Download Drive Firmware warning opens and prompts: ″Do you want to 

continue?″ Type yes  and click OK  to start the drive firmware download. 

13.   The Download Progress window opens. Do not intervene until the download 

process completes. 

14.   Every drive scheduled for firmware download will be designated as in  

progress  until successful  or failed.

Note:   Complete the following two steps if you receive a failure. 

a.   Click the Save  as  button to save the error log. 

b.   On the Subsystem Management window’s menu bar, click 

Advanced  →Trouble  Shooting  → Open  Event  Log  and complete 

the following tasks necessary to save the storage subsystem event 

log before contacting your IBM Service Representative and 

proceeding to step 16. 

1)   Click the Select  all  button. 

2)   Click Save  the  Storage  Subsystem  Event  Log.

15.   When the Close  button appears active, the drive firmware download process is 

complete. 

16.   Click Close  to exit the Download Progress window. 

17.   Use either of the following procedures to determine or verify what level of drive 

firmware resides on a particular drive: 

v   Right-click on that drive in the Logical/Physical View in the Subsystem 

Management window and click Properties. The associated drive firmware 

version will be listed in the drive properties table. 

v   Right-click on Storage  Subsystem  → View  Profile  in the Logical/Physical 

View of the Subsystem Management window.

Downloading Storage Manager version 8.x drive firmware 

To download drive firmware for DS4000 Storage Manager version 8.x, perform the 

following steps: 

 1.   From the Enterprise Management window, select a storage subsystem. 

 2.   Click Tools  → Manage  Device. The Subsystem Management window opens. 

 3.   Click Advanced  → Download  → Drive  Firmware. The Download Drive 

Firmware window opens. It presents a list of all installed drives. 

 4.   From the list of all installed drives, select the drive to which you plan to 

download drive firmware. 

Press and hold the Ctrl  key while using your mouse to select multiple drives 

singly, or press and hold the shift  key while selecting multiple drives in series 

by using your mouse pointer. 

 5.   Click Browse  to identify the directory that contains the drive firmware that you 

intend to download. 

 6.   Select the file containing the drive firmware that you intend to download. 

 7.   Select Start. The Confirm Download window appears. 
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8.   Type yes  when the Confirm Download window prompts: Are  you  sure  you  

want  to  continue?  

 9.   The download begins and the Status window indicates progress. Do not 

intervene until the download process completes. 

10.   When the Cancel  button appears active, the download process is complete. 

Press Cancel  to close the Status window. 

11.   To determine or verify the level of drive firmware residing on a particular drive, 

click View  → Subsystem  Profile  in the Logical/Physical View of the Subsystem 

Management window.

Bringing storage subsystems and drive loops into optimal state 

Note:   For additional information on how to make this determination, see the 

DS4000  Problem  Determination  Guide  associated with your particular 

DS4000 hardware model. 

After you have updated or verified that a DS4000 Storage Server is using the latest 

firmware and NVSRAM: 

__ Step 1.   Bring the DS4000 Storage Server to its optimal  state before 

reconfiguring it with new hardware. 

__ Step 2.   Use the DS4000 Storage Manager client program to display the status 

of the DS4000 Storage Server and to correct any problems that might 

cause the DS4000 Storage Server to enter its Needs  Attention  state. 

__ Step 3.   Verify that all indicator lights on the storage subsystem are in their 

optimal  state. 

__ Step 4.   In addition, use the Read_Link_Status  function of the DS4000 Storage 

Manager client program and the DS4000 Storage Server MEL to verify 

that all components in the drive loop are in their optimal  states (that is, 

there are no drive loop component errors in the event log and no errors 

in the Read_Link_Status  window.) If you are using controller firmware 

06.10.xx.xx, use the drive channel diagnostics to determine if the drive 

loop is optimal. See the DS4000 Storage Manager Client program 

Subsystem Management window Online help for more information on 

the RLS and drive channel diagnostics if they are supported by the 

installed version of your controller firmware. 

Drive channel diagnostics are only available if you are using controller 

firmware version 06.10.xx.xx. 

__ Step 5.   If the arrays are in degraded  state due to a failed drive, correct the 

problem before migration.

If necessary, contact the IBM Help Center in your geography for assistance with 

event log interpretation. 

It is necessary for certain tasks to complete before proceeding to add drives or 

enclosures. Before you add drives or enclosures, verify that the storage subsystem 

involved is not performing any of the following tasks. 

v   Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or 

dynamic capacity expansion [DCE]) 

v   Logical drive segment size modification 

v   Array RAID-level modification 

v   User-initiated array redundancy checking (menu option Array  → Check  

Redundancy  in the Subsystem Management window) 
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v   Remote mirror logical drive synchronization 

v   FlashCopy® or VolumeCopy logical drive creation 

v   Logical drive reconstruction or copyback. This action is sometimes referred to as 

logical drive sparing.

Saving the storage subsystem profile 

Use the DS4000 Storage Manager client program to save a DS4000 Storage 

Server profile. Such a profile is necessary to restore a storage subsystem 

configuration in the event of a catastrophic failure. Migration from one DS4000 

Storage Server configuration to another will require that you save both DS4000 

Storage Server configuration profiles involved. For details on this procedure, see 

one of the following: 

v   DS4000 Storage Manager client program Client Subsystem Management window 

online help 

v   IBM  TotalStorage  DS4000  Storage  Manager  installation  and  support  guide  

associated with your particular operating system environment located at: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

v   Saving  a module  profile  report  and  state  capture  information  to  help  prevent  data  

loss  located at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-4VVPEF

Important:  Do not store DS4000 Storage Server profiles in the same location as 

the logical drives defined on your DS4000 Storage Server. Should you do so, and a 

RAID array failure occurs during subsequent migration, the data will be lost. 
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Chapter  3.  Adding  one  or more  new  hard  drives  

While adding a hard drive to either a controller or a drive expansion enclosure, 

observe these important rules: 

v   Observe proper electrostatic discharge (ESD) procedures when handling 

electronic equipment. 

v   Never alter the physical configuration of a DS4000 Storage Server while it is 

powered off unless you are instructed to do so as part of a DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Server while it is powered off. 

v   Any hard drive, whether new or old, might contain configuration data. Unless you 

intend to migrate a drive from another DS4000 Storage System (retaining its 

configuration data), always use the following procedure to add one or more hard 

drives to a functioning DS4000 Storage Server configuration. 

v   The following DS4000 storage server devices support only 2 Gbps fibre channel 

hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers 

1 Gbps fibre channel drives will not spin up when you insert them into their drive 

slots. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID or Model Number. Hard drives with ID or Model Number values that end 

with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example, 

“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that 

appear on several 1 Gbps fibre channel hard drives. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop. 

v   Do not install SATA drives in fibre channel device enclosures. 

v   Do not install fibre channel drives in SATA device enclosures.

The following procedure outlines the steps necessary to add one or more new hard 

drives to empty drive slots in either DS4100, FAStT200, or DS4300 controllers or in 

EXP100, EXP500, EXP700, or EXP710 storage expansion enclosures. If you plan 

to add a used drive, be sure that there is no configuration data on the drive that you 

need to preserve. Add drives to a DS4000 Storage Server only while it is powered 

on and in optimal  state. See the DS4000  Problem  Determination  Guide  associated 

with your particular DS4000 hardware model or “Bringing storage subsystems and 

drive loops into optimal state” on page 29 for additional information on how to make 

this determination. 

Activity 1: Disabling the drive migration settings 

Before you add drives to the subsystem, perform this activity to remove any 

configuration data that they may contain. 

__ Step 1.   Open the Storage Manager client program’s Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 storage subsystem to which you 

intend to add drives and click Execute  Script. 

__ Step 3.   A script editor window opens. Click File  → Load  Script. 
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__ Step 4.   A Load Script file selection window opens. Locate and select the file 

named DisableDriveMigration.scr and click OK. The 

DisableDriveMigration.scr file is normally located in the SCRIPTS  

directory of the IBM DS4000 Storage Manager Installation Compact 

Disc (CD). Use this file to reset the DS4000 storage subsystem setting 

to ignore configuration data that might reside on newly discovered hard 

drives. Figure 14 on page 35 provides a listing of the 

DisableDriveMigration.scr file. 

__ Step 5.   Click Tools → Verify  and  Execute  to run the script. 

__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you used the DisableDriveMigration.scr script associated with this 

document and described in Figure 13 on page 34, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by clicking 

Advanced  → Reset  Controller. Then, follow the instructions in the 

Reset Controller window when it opens.

Activity 2: Inserting drives 

__ Step 1.   Insert drives as pairs (two at a time) into the empty drive slots. 

__ Step 2.   Wait until each drive pair has fully spun up and displayed in the 

DS4000 Storage Subsystem Management window before inserting the 

next drive pair.

Activity 3: Re-enabling the drive migration settings 

Perform this activity to re-enable the drive migration settings if you performed 

“Activity 1: Disabling the drive migration settings” on page 31 to disable DS4000 

storage subsystem drive migration settings. If you do not, whenever you might 

subsequently, even momentarily remove a drive from the storage subsystem for any 

reason, its configuration data will be cleared. When the storage subsystem next 

recognizes such a drive, it will display it as unconfigured. 

Attention:  In order to prevent data loss, set the DS4000 Storage Server drive 

migration to enable  after you complete the hard drive addition process. 

__ Step 1.   Open the Storage Manager client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 storage subsystem to which you 

want to add drives and click Execute  Script. 

__ Step 3.   A script editor window opens. Click File  → Load  Script. 

__ Step 4.   A Load Script file selection window opens. Locate, and select the file 

named EnableDriveMigration.scr and click OK. The file 

EnableDriveMigration.scr is normally located in the SCRIPTS  directory of 

the IBM DS4000 Storage Manager Installation CD. Use this file to reset 

the DS4000 storage subsystem setting in order to check for 

configuration data that might reside on newly discovered hard drives. 

Figure 13 on page 34 provides a listing of the EnableDriveMigration.scr 

file. 

__ Step 5.   Click Tools → Verify  and  Execute  to run the script. 
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__ Step 6.   When the script completes execution, reset both DS4000 controllers to 

enable the DS4000 drive migration setting. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 13 on page 34, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. 

To reset the controllers, open the Storage Subsystem Management 

window and sequentially (one at a time) reset each controller by clicking 

Advanced  → Reset  Controller, and then following the instructions in 

the Reset Controller window when it opens. 

Result:  The newly added drives are ready for you to configure and map 

to host servers.

The next two figures list the EnableDriveMigration.scr and DisableDriveMigration.scr 

files. 
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// Name:  Enable  Drive  Migration  

// 

// Date:  05-08-2004  

// Revision:  1.3  

// Comments:  

// This  script  is intended  to work  with  controllers  at Firmware  05.30.xx.xx  and  

// higher  only.  

// 

// This  script  returned  the  FAStT  to it’s  default  operation  of importing  

// configuration  informration  from  disks.  

// 

// This  script  will  reboot  both  controllers  in the  FAStT  unit.  If your  

// hosts  are  configured  for  multi-path  support,  this  can be done  with  I/O  

// running  to the  controllers.  If your  hosts  are  not  configured  for  

// redundant  access  you  must  schedule  downtime  before  running  this  

// script.  

// 

// See  the  directions  at the  bottom  of this  script  if you  do not  have  multi  

// path  software  installed  and  wish  to prevent  the  controller  restarts  

// 

// Show  the  current  state  of Drive  Migration  

show  "Showing  the  current  state  of Drive  Migration  (80=Off,  82=On)";  

show  controller[a]  nvsrambyte[0x35];  

show  controller[b]  nvsrambyte[0x35];  

// 

// Setting  Drive  Migration  to Enable  

show  "Setting  Drive  Migration  to Enable";  

set  controller[a]  nvsrambyte[0x35]  = 0x02,0x00;  

set  controller[b]  nvsrambyte[0x35]  = 0x02,0x00;  

show  controller[a]  nvsrambyte[0x35];  

show  controller[b]  nvsrambyte[0x35];  

// 

// Reset  Controllers  to make  changes  active.  Note:  

// To prevent  the  controllers  from  restarting,  add ’//’  to the  beginning  

// of each  of  the  lines  below.  This  will  comment  out the  restart  of  the 

// controllers.  Important:  The  controllers  will  have  to be restarted  for  the  

// changes  in this  script  to take  effect.  

// 

show  "Resetting  controller  A";  

reset  Controller  [a];  

show  "Resetting  controller  B";  

reset  Controller  [b];  

show  "Drive  Migration  is now  enabled.";  

  

Figure  13.  EnableDriveMigration.scr  file  listing
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// Name:  Disable  Drive  Migration  

// 

// Date:  05-08-2004  

// Revision:  1.3  

// Comments:  

// This  script  is intended  to work  with  controllers  at Firmware  05.30.xx.xx  and 

// higher  only.  

// This  script  allows  the  addition  of disk  drives  while  the  system  is running  

// and  by clearing  the  configuration  of  any  drives  as unused  capacity  

// regardless  of past  configuration  of these  drives.  

// 

// Attention:  This  setting  should  not  be left  active  after  the  new  disks  have  

// been  added  to the  subsystem.  Leaving  this  setting  active  could  

// cause  the  configuration  for  the  FAStT  to be lost  if the  FAStT  is 

// power  cycled  incorrectly.  Please  run  the EnableDriveMigration.scr  

// after  all  the  disks  are  added.  

// 

// 

// This  script  will  reboot  both  controllers  in the  FAStT  unit.  If your  

// hosts  are  configured  for  multi-path  support,  this  can be done  with  I/O 

// running  to  the  controllers.  If your  hosts  are not  configured  for 

// redundant  access  you  much  schedule  downtime  before  running  this  

// script.  

// 

// Show  the  current  state  of Drive  Migration  

show  "Showing  the  current  state  of Drive  Migration  (80=Off,  82=On)";  

show  controller[a]  nvsrambyte[0x35];  

show  controller[b]  nvsrambyte[0x35];  

// 

// Setting  Drive  Migration  to Disable  

show  "Setting  Drive  Migration  to Disable";  

set  controller[a]  nvsrambyte[0x35]  = 0x02,0x02;  

set  controller[b]  nvsrambyte[0x35]  = 0x02,0x02;  

show  controller[a]  nvsrambyte[0x35];  

show  controller[b]  nvsrambyte[0x35];  

// 

// Reset  Controllers  to make  changes  active  

// To prevent  the  controllers  from  restarting,  add ’//’  to the  beginning  

// of each  of the  lines  below.  This  will  comment  out  the  restart  of the 

// controllers.  Important:  The  controllers  will  have  to be restarted  for  

// the  changes  in this  script  to take  effect.  

show  "Resetting  controller  A";  

reset  Controller  [a];  

show  "Resetting  controller  B";  

reset  Controller  [b];  

// 

show  "Drive  Migration  is  now  disabled.  Add  the new  drives  to the  subsystem,";  

show  "then  execute  the  EnableDriveMigrationScript.scr  to re-enable  drive  "; 

show  "migration.";  

  

Figure  14.  DisableDriveMigration.scr  file listing
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Chapter  4.  Adding  expansion  units  containing  new  hard  

drives  

While adding storage expansion enclosures containing new hard drives, observe 

these important rules: 

v   Observe proper ESD procedures when handling electronic equipment. 

v   Never alter the physical configuration of a DS4000 Storage Server while it is 

powered off unless you are instructed to do so as part of DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Server while it is powered off. 

v   Any hard drive, whether new or old, might contain configuration data. Unless you 

intend to migrate drives from another DS4000 Storage System (retaining their 

configuration data), always use the following procedure to add one or more 

storage expansion enclosures containing one or more hard drives to a 

functioning DS4000 Storage Server configuration. 

v   The following DS4000 storage server devices support only 2 Gbps fibre channel 

hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers

1 Gbps fibre channel drives will not spin up when you insert them into their drive 

slots. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID or Model Number. Hard drives with ID or Model Number values that end 

with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example, 

“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that 

appear on several 1 Gbps fibre channel hard drives. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop. 

v   Do not install SATA drives in fibre channel device enclosures. 

v   Do not install fibre channel drives in SATA device enclosures.

The following procedure describes the steps required to add one or more DS4000 

storage expansion enclosures containing new drives to a functioning DS4000 

Storage Server configuration. 

Activity 1: Preliminary activities 

Add a new DS4000 storage expansion enclosure as follows: 

__ Step 1.   Verify that the DS4000 Storage Server is both powered on and in 

optimal  state. See the DS4000  Problem  Determination  Guide  

associated with your particular DS4000 hardware model or “Bringing 

storage subsystems and drive loops into optimal state” on page 29 for 

additional information on how to make this determination. You can 

perform this process while the DS4000 Storage Server is processing 

I/O from or to the host server. However, because the drive loops are 

interrupted momentarily during the addition process, schedule additions 

to occur during time periods of low I/O between the DS4000 storage 

servers and host servers. Review the readme and the IBM  TotalStorage  

DS4000  Storage  Manager  installation  and  support  guide  associated 

with the operating system environment of the host servers that connect 
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to the DS4000 Storage Server for any additional restrictions or required 

preparation tasks specific to your particular operating system 

environment. You will find the IBM  TotalStorage  DS4000  Storage  

Manager  installation  and  support  guides  at: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

__ Step 2.   Unpack and mount any additional storage expansion enclosures in the 

rack using the mounting hardware supplied with each storage 

expansion enclosure. 

Important:  Do not fully insert hard drives into the enclosures at this 

time. Keep them unlatched and no less than ½-inch away from their full 

insertion points in the drive slots. 

__ Step 3.   Set the enclosure ID of the additional storage expansion enclosures. 

Each drive enclosure in the DS4000 storage subsystem drive loop must 

have a unique drive enclosure ID. In a EXP500 storage expansion 

enclosure, there is an enclosure ID switch mounted on each of two 

ESM canisters. Set each ESM canister’s enclosure ID switch in the 

EXP500 drive enclosure to the same unique number in the drive loop. 

In a EXP700 storage expansion enclosure, the only enclosure ID switch 

is mounted between the power supplies. See the appropriate DS4000  

storage  expansion  unit  installation  and  user’s  guide  for additional 

information. Figure 15 illustrates the location of speed switches on the 

EXP100, EXP700, EXP710, and EXP500 storage enclosures.
 

If the DS4000 Storage Server to which the storage expansion enclosure 

will attach is either a FAStT200 or DS4300, the enclosure IDs of 

additional storage expansion enclosures must differ from the FAStT200 

or DS4300 Storage Server enclosure IDs, which are normally set to “0” 

at the factory. 

__ Step 4.   Verify that the EXP700 Storage Expansion Unit speed switch is set to 

the correct drive loop speed. 

Note:   If a fibre channel enclosure speed switch was originally set to 1 

Gbps, do not automatically set it to 2 Gbps unless you are sure 

that each fibre channel hard drive that it now contains is capable 
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Figure  15. EXP100,  EXP500,  EXP700,  and  EXP710  enclosure  ID and  speed  switches
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of 2 Gbps operation and that you have installed the latest 

firmware enabling their operation in a 2 Gbps fibre channel 

environment. 

__ Step 5.   Insert the small form-factor pluggables (SFPs) or gigabit interface 

converters (GBICs) into only those ports you intend to use. Do not 

leave GBICs or SFPs inserted into port slots without connecting them to 

other ports using cables.

Activity 2: Cabling new storage expansion units 

To complete addition of DS4000 storage expansion enclosures, cable the new 

storage expansion enclosures to the end of the functioning storage expansion 

enclosure drive loop to which you are migrating them. Add only one enclosure at a 

time to a functioning drive loop if you intend to attach multiple storage expansion 

enclosures. 

The cabling instructions in the steps that follow are based on the cable routing 

scheme that is documented in IBM  TotalStorage  DS4000  Storage  Manager  

installation  and  support  guides. The cabling instructions illustrated in Figure 16 on 

page 41, Figure 17 on page 42, and Figure 18 on page 43 describe cabling a 

DS4000 EXP700 Storage Expansion Enclosure to the redundant drive loop of a 

functioning DS4300 Storage Server (model 60X or 60U). 

The general cabling scheme for DS4000 external drive enclosures is described in 

the IBM  TotalStorage  DS4000  Fibre  Channel  Cabling  Guide  available at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-4KELS5 

See also “Storage subsystem loop schemes” on page 12. 

__ Step 1.   Extend one of the drive loops (that is, drive loop A) in a DS4000 

Storage Server redundant drive loop pair by connecting the OUT  port of 

the last storage expansion enclosure to the IN  port of the new storage 

expansion enclosure as shown in Figure 16 on page 41. 

Warning:  Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal  state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Server controllers. This happens when 

two or more drives in the arrays cannot be reached through either drive 

loop in the redundant drive loop pair. 

__ Step 2.   Power on the newly added storage expansion enclosure unit. 

__ Step 3.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 4 on page 40. For port 

bypass: 

__ a.   Verify that the SFPs and GBICs or fibre cables are in good 

condition. 

__ b.   Remove and reinsert SFPs, GBICs and fibre cables. 

__ c.   Make sure the new drive expansion enclosure speed switch is 

set to the same speed as the existing drive expansion 

enclosures and the DS4000 Storage Server speed setting. 
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__ d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current settings in 

the existing drive expansion enclosures and storage server.

Call the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 4.   In the other drive loop (that is, drive loop B) in a DS4000 Storage 

Server redundant drive loop pair, remove the connection from the 

storage subsystem drive loop port to the OUT  port of the last storage 

expansion enclosure and connect it to the OUT  port of the new drive 

enclosure as shown in Figure 17 on page 42. 

__ Step 5.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the storage subsystem drive loop port and the 

OUT  port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive  enclosure  lost  

redundancy  path  error. See the preceding step 3 on page 39 for 

possible corrective actions, if needed. 

__ Step 6.   In drive loop B, cable the new drive enclosure’s IN  port to the OUT  port 

of the last enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 18 on page 43. 

__ Step 7.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive  enclosure  lost  redundancy  path  error.
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Figure  16.  First  connection:  Cabling  a single  drive  enclosure  to a functioning  drive  loop
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Figure  17. Second  connection:  Cabling  a single  drive  enclosure  to a functioning  drive  loop
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Activity 3: Disabling storage subsystem drive migration settings 

When you have completed cabling the new storage expansion enclosures, disable 

DS4000 storage subsystem drive migration settings as follows: 

__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 storage subsystem to which you 

want to add drives, and select Execute  Script. 

__ Step 3.   A script editor window opens. Click File  → Load  Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the 

DisableDriveMigration.scr  file and click OK. The file 
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Figure  18.  Third  (final)  connection:  Cabling  a single  drive  enclosure  to a functioning  drive  

loop
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DisableDriveMigration.scr file is normally in the SCRIPTS  directory of the 

IBM DS4000 Storage Manager Installation CD. This file is used to reset 

the DS4000 storage subsystem setting, in order to treat all 

newly-discovered hard drives as “new” drives, and to ignore any 

configuration information that might exist in the new hard drives. 

Figure 14 on page 35 contains the DisableDriveMigration.scr file listing. 

__ Step 5.   Click Tools → Verify  and  Execute  to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the disable drive migration settings effective. If you used the 

DisableDriveMigration.scr  file described in this document in Figure 14 

on page 35, you do not need to perform this step because the last two 

commands in the script file automatically reset the controllers. To reset 

the controllers, open the Storage Subsystem Management window and 

alternately (one at a time) reset each controller by clicking Advanced  → 

Reset  Controller  and following the instructions in the Reset Controller 

window when it opens.

Activity 4: Inserting drives and cabling additional storage expansion 

units 

Once you have disabled DS4000 storage subsystem drive migration settings, insert 

drives and connect additional storage expansion enclosures to complete the 

installation process as follows: 

__ Step 1.   Insert the appropriate drives into empty drive slots in the new enclosure 

in pairs (two at a time). Wait until the inserted drive pair fully spins up 

and displays in the DS4000 Storage Subsystem Management window 

before inserting the next drive pair. 

__ Step 2.   To connect additional storage expansion enclosures to the functioning 

drive loop pair, perform Activity 1: Preliminary activities step 2 on page 

38 through step 5 on page 39, Activity 2: Cabling new storage 

expansion units step 1 on page 39 through step 6 on page 40, and step 

1 (immediately preceding this step) for each additional storage 

expansion enclosure that you intend to add . (See Figure 19 on page 

45.) When you have completed adding enclosures, proceed to Activity 

5: Re-enabling drive migration settings step1 on page 46 to re-enable 

the drive migration settings.
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Activity 5: Re-enabling drive migration settings 

If you performed steps 1 on page 43 through 6 on page 44 of Activity 3: Disabling 

storage subsystem drive migration settings to disable DS4000 storage subsystem 

drive migration settings, perform the following steps 1 on page 46 through 6 on 

page 46 to re-enable the drive migration settings. If you should ever momentarily 

remove a drive from the storage subsystem, the storage subsystem clears its 

configuration data when it later recognize it. When this happens, the drive displays 

as unconfigured. 

Attention:  In order to prevent data loss, set the DS4000 Storage Server drive 

migration setting to enable  after you complete the hard drive addition process. 
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Figure  19.  Cabling  a second  drive  enclosure  to a functioning  drive  loop
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__ Step 1.   Open the Storage Manager Client program Enterprise Management 

window. 

__ Step 2.   Right-click on the name of the DS4000 storage subsystem to which you 

want to add drives and click Execute  Script. 

__ Step 3.   A script editor window opens. Click File  → Load  Script. 

__ Step 4.   A Load Script file selection window opens. Locate and select the 

EnableDriveMigration.scr file and click OK. The file 

EnableDriveMigration.scr file is normally in the SCRIPTS  directory of the 

IBM DS4000 Storage Manager Installation CD. Use this file to reset the 

DS4000 storage subsystem setting in order to check for any 

configuration data that might exist on the newly discovered hard drives. 

__ Step 5.   Click Tools → Verify  and  Execute  to run the script. 

__ Step 6.   When the script execution completes, reset both DS4000 controllers to 

make the setting effective. 

If you use the EnableDriveMigration.scr script associated with this 

document and described in Figure 13 on page 34, it is not necessary 

for you to perform this step because the last two commands in that 

script file automatically reset the controllers. To reset the controllers, 

open the Storage Subsystem Management window and alternately (one 

at a time) reset each controller by clicking Advanced  → Reset  

Controller  and following the instructions in the Reset Controller window 

when it opens. 

Result:  The newly added drives are now ready for you to configure and map to 

host servers. 

Note:   Listings of the EnableDriveMigration.scr  and DisableDriveMigration.scr  

files are found in Figure 13 on page 34 and Figure 14 on page 35.
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Chapter  5.  Migrating  one  or more  hard  drives  

Note:   When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Server, move all of the hard drives from the first 

DS4000 Storage Server as an independent ’set’ to the destination DS4000 

Storage Server. Before moving hard drives as a ’set’ from subsequent 

DS4000 storage servers, ensure that all of the hard drives from the previous 

’set’ have been successfully transferred to the destination DS4000 Storage 

Server. If you do not transfer hard drives as ’sets’ to the destination DS4000 

Storage Server, the newly relocated array may not appear in the Subsystem 

Management window. 

While migrating a hard drive to either a controller or a drive expansion enclosure, 

observe these important rules: 

v   Observe proper ESD procedures when handling electronic equipment. 

v   Never alter the physical configuration of a DS4000 Storage Server while it is 

powered off unless you are instructed to do so as part of DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Server while it is powered off. 

v   Any hard drive, whether new or old, might contain configuration data. Use this 

procedure to preserve the configuration and user data in one or more hard drives 

that you will migrate to a functioning DS4000 Storage Server configuration. Do 

not use this procedure if you are unsure of the quality of the data on the hard 

drives. 

v   The following DS4000 storage server devices support only 2 Gbps fibre channel 

hard drives: 

–   DS4000 EXP700 storage expansion units 

–   DS4000 EXP710 storage expansion units 

–   DS4300 storage servers 

1 Gbps fibre channel drives will not spin up when you insert them into their drive 

slots. 

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine 

its ID and Model Number. Hard drives whose ID/Model Number values end with 

“04FC” or “03FC” are 1 Gbps fibre channel drives. For example, “ST173404FC”, 

“ST318203FC” and “ST136403FC” are model numbers that appear on several 1 

Gbps fibre channel hard drives. 

v   Do not mix SATA and fibre channel drives or enclosures together in the same 

drive loop. 

v   Do not install SATA drives in fibre channel device enclosures. 

v   Do not install fibre channel drives in SATA device enclosures.

The following procedure describes the steps that you must perform to migrate one 

or more drives from a functioning DS4000 Storage Server configuration to another 

DS4000 Storage Server configuration. Drives described in the following steps are 

those that contain configuration data that you want to preserve. Add such drives to 

a DS4000 Storage Server only while it is powered on and in its optimal  state. See 

the DS4000  Problem  Determination  Guide  associated with your particular DS4000 

hardware model or “Bringing storage subsystems and drive loops into optimal state” 

on page 29 for additional information on how to assess the state of a DS4000 

Storage Server. 
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Tip:  Before you attempt to complete the drive migration procedure, review and 

perform the steps documented in Chapter 2, “Prerequisites to adding capacity and 

hard drive migration,” on page 23. 

The procedure for migrating hard drives which contain configuration data that you 

want to preserve is as follows: 

Activity 1: Preliminary activities 

Before you remove drives from a functioning DS4000 Storage Server, perform the 

following steps to ensure that you successfully migrate the drives to the destination 

DS4000 Storage Server. 

__ Step  1.   Perform a backup of the logical drives defined in the hard drives that 

you plan to migrate. 

__ Step  2.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Make 

sure that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, the 

Microsoft MSCS service periodically writes to the “Quorum” disk.) 

__ Step  3.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:   

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.

__ Step  4.   Verify that the DS4000 Storage Server controller and NVSRAM of both 

the source and destination systems are at or above levels described in 

Table 16 on page 24. 

__ Step  5.   Verify that the names of the logical drives that are associated with 

hard drives on both the source and destination systems are unique. If 

they are not, make the necessary changes. 

__ Step  6.   In addition to array configuration information, any storage partitioning 

configuration data that may reside on drives you plan to migrate will 

migrate with those drives when installed on another DS4000 Storage 

Server. For this reason, take the following precautions to facilitate the 

migration process and prevent problems in storage partitioning 

configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been 

enabled both on a drive’s original and destination DS4000 storage 

servers, assure that the defined host ports, hosts, and host group 

names are unique to each DS4000 storage server involved in the 

migration. 

b.   If you must use identical names on both DS4000 storage servers, 

make the names unique before you perform the drive migration. 

If necessary, customize the storage partitioning information on the 

DS4000 storage server to which you have migrated the drives after 

you complete the migration. 

__ Step  7.   Delete any flashcopies of the logical drives defined on the drives that 

you plan to migrate. 

__ Step  8.   Remove any remote mirror relationships using the logical drives 

defined on the drives that you plan to migrate. 
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__ Step  9.   Ensure that the arrays and logical drives are in optimal  state before 

starting the migration process. See the DS4000  Problem  

Determination  Guide  associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 29 for additional information on how to make this 

determination. 

__ Step 10.   Place the arrays defined in the hard drives that you plan to migrate in 

offline  state. To do so, right-click on the name of the array in the 

Storage Subsystem Management window and click Place  → Offline. 

__ Step 11.   If you migrate drive expansion enclosures from a 1 Gbps fibre channel 

environment to a 2 Gbps fibre channel environment, verify that the 

fibre channel hard drives that you plan to migrate are each capable of 

2 Gbps operation and that you have installed the latest firmware 

enabling them to work properly in a 2 Gbps fibre channel environment. 

__ Step 12.   Save the DS4000 storage subsystem profile of the functioning DS4000 

Storage Server configuration to which the migration will occur in a 

location other than that of the logical drives you plan to migrate. 

__ Step 13.   If you migrate the drives to a single controller DS4000 Storage Server 

(for example, DS4300 Storage Server Model 6LU or 6LX), change the 

logical drive’s preferred owner to Controller A using the DS4000 

Storage Manager client program before taking it offline and removing it 

from the DS4000 Storage Server. To set Controller A as the logical 

drive preferred owner, right-click the logical drive entry in the 

Subsystem Management window and select Change  → 

Ownership/Preferred  Path  → Controller  A.

Activity 2: Removing the drives to be migrated 

While the functioning DS4000 Storage Server is still powered on, remove the hard 

drives that you plan to migrate one at a time using the following steps: 

__ Step 1.   Press on the inside of the bottom of the tray handle to release the blue 

latch. 

__ Step 2.   Lift the closed latch to its open position. (The latch is at a 90-degree 

angle to the front of the drive when open.) 

__ Step 3.   Using the handle, slowly pull the drive ½-inch out of its drive slot. 

__ Step 4.   Wait at least 20 seconds to allow the hard drive to spin down before 

fully removing it from the drive slot. 

__ Step 5.   Place the hard drive into an ESD bag or container before moving it to 

the new DS4000 Storage Server. 
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Legend:  

�1�  Blue latch 

�2�  Drive CRU handle 

�3�  Tray 

�4�  FC hard drive

Attention:  Orient drives horizontally and place them in appropriate ESD 

bags or containers before relocation. When in transit, use only moving 

equipment that prevents shock to the drives. Never stack drives.

Activity 3: Inserting the drives to be migrated 

Note:   When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Server, move all of the hard drives from the first 

DS4000 Storage Server as an independent ’set’ to the destination DS4000 

Storage Server. Before moving hard drives as a ’set’ from subsequent 

DS4000 storage servers, ensure that all of the hard drives from the previous 

’set’ have been successfully transferred to the destination DS4000 Storage 

Server. If you do not transfer hard drives as ’sets’ to the destination DS4000 

Storage Server, the newly relocated array may not appear in the Subsystem 

Management window. 

__ Step 1.   While the destination DS4000 Storage Server is powered on, insert the 

migrating drives into the empty drive slots in pairs. Wait until the 

inserted drive pair is fully spun up and displayed in the DS4000 Storage 

Subsystem Management window before inserting the next drive pair. 

__ Step 2.   As the DS4000 Storage Server recognizes the drives, it reads and 

displays the array and logical drive information in the Logical/Physical 

view of the DS4000 Storage Subsystem Management window. The 
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Figure  20. Drive  CRU  assembly
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storage subsystem represents arrays in offline  state until it recognizes 

that you have inserted all of the drives that comprise an array. 

__ Step 3.   After you migrate all of the drives, manually change the state of the 

arrays and logical drives involved from optimal  to online  state if it has 

not changed automatically. To do so, right-click on the array name in the 

Storage Subsystem Management window and select Place  → Online. If 

any of the following conditions persist, contact the IBM Help Center in 

your geography for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed  unconfigured drive icon ( 

  

) or the Failed  configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 

v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Attention:  Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize  from the pull-down menu) if 

it contains configuration or user data. Initializing any drives in a defined 

array causes all hard drives known to comprise that array to return to 

the Unconfigured  Capacity  storage pool, deleting their array definitions 

from the DS4000 Storage Server configuration. The user data on such 

drives is lost. 

Result:  Once the arrays are online, they are ready to for you to 

configure and map to host servers. You might also then recreate 

flashcopies of the logical drives. 

__ Step 4.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 5.   The DS4000 Storage Server that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 

LUNs”. In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete  from the pull-down menu.

Migrating arrays within storage subsystems 

Important:  

1.   Assure that your controller firmware is at or above the level documented in 

Table 16 on page 24. Do not rearrange more than two or three arrays at a time. 

2.   Unmount the file systems to flush I/O from the server cache to disks.

Notes:   

a.   In a Microsoft Windows environment, remove the drive letter or the mount 

points of the mapped LUNs instead of unmounting the file systems. 

b.   Consult documentation associated with your particular operating system for 

detailed information regarding the Unmount procedure.

Using the configuration data on existing drives, it is possible to redistribute the 

drives that made up an RAID array across a storage subsystem to which you may 

be adding expansion enclosures. Figure 21 on page 52 illustrates a storage array 

distributed across three drives on a single storage device before and after 

reordering. When you redistribute each drive to a different position in the same 
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storage enclosure as recommended, the array automatically redistributes 

accordingly. 

 

Figure 22 illustrates a storage array distributed across three drives on a single 

storage device before reordering across two storage devices. When the drives are 

redistributed across an additional storage enclosure in the storage subsystem as 

recommended, the array automatically redistributes accordingly. 

 

Figure 23 illustrates two arrays distributed across five drives and two storage 

enclosures before and after reordering the same drives across other drive slots in 

the same two storage enclosures. 

Important:  Completely remove all of the drives of both arrays from both storage 

enclosures and wait for the storage manager to mark the arrays/logical drives as 

missing before you attempt to reinsert any of the drives from either enclosure. After 

you insert the drives associated with the first array, wait until that array comes 

online in a DS4000 Storage Manager Subsystem Management window before you 

insert the drives associated with the second array. 

 

Perform the following steps to ensure success when you reorder drives that make 

up arrays across different drive slots in the same DS4000 Storage Server 

configuration. 

 1.   Start the DS4000 Storage Manager Client program and open the Subsystem 

Management window (for the DS4000 Storage Subsystem which drives you 

intend to reorder). 

 2.   Set the arrays that you plan to move offline. 
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Figure  21. Manner  recommended  for reordering  a defined  array  using  empty  slots  in one  

storage  enclosure
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Figure  22. Manner  recommended  for reordering  a defined  array  using  empty  slots  in two  

storage  enclosures
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Figure  23. Reordering  multiple  defined  arrays  across  previously  used  slots  in two  storage  

enclosures
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3.   Mark the drives in the arrays. 

 4.   Unlatch the drives from their respective slots. Wait at least 2 minutes for each 

drive to spin down. 

 5.   Slowly and carefully remove the drives from their slots. 

 6.   Assure that all of the drives that made up the arrays are completely removed 

from their slots. 

 7.   Wait for the storage manager to mark the arrays/logical drives as missing in 

the Subsystem Management window. See Figure 24.
 

 8.   Carefully reinsert all of the drives that made up an array only into the empty 

slots of the storage enclosure. Do not insert the drives into empty slots that are 

part of another array definition whose drives are still inserted in the storage 

enclosures. Data on the drives you insert will be replaced with the 

reconstructed data from the previously installed RAID array. 

 9.   The system will recognize the array and bring it online when you finish 

inserting all of the drives. 

10.   Repeat steps 8 and 9 for each of the arrays that were removed from the 

storage enclosure. 

11.   Save the storage subsystem profile. See “Saving the storage subsystem 

profile” on page 30 for information on performing this activity.

Note:   Do not reinsert drives from multiple arrays in random order into the 

storage enclosures.
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Figure  24.  Subsystem  Management  Logical/Physical  View  of Missing  Logical  Drives
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Chapter  6.  Migrating  expansion  units  containing  hard  drives  

Note:   When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Server, move all of the hard drives from the first 

DS4000 Storage Server as an independent ’set’ to the destination DS4000 

Storage Server. Before moving hard drives as a ’set’ from subsequent 

DS4000 storage servers, ensure that all of the hard drives from the previous 

’set’ have been successfully transferred to the destination DS4000 Storage 

Server. If you do not transfer hard drives as ’sets’ to the destination DS4000 

Storage Server, the newly relocated array may not appear in the Subsystem 

Management window. 

While migrating a fibre channel or SATA hard drive to either a controller or a drive 

expansion enclosure, observe these important rules: 

v   Observe proper ESD procedures when handling electronic equipment. 

v   Never alter the physical configuration of a DS4000 Storage Server while it is 

powered off unless you are instructed to do so as part of DS4000 configuration 

procedure. Specifically, never attach storage components to or remove storage 

components from a configured DS4000 Storage Server while it is powered off. 

v   Use this procedure to preserve the configuration and user data in one or more 

fibre channel hard drives that you will migrate to a functioning DS4000 Storage 

Server configuration. Do not use this procedure if you are unsure of the quality of 

the data on the hard drives. Import of incorrect configuration data from hard 

drives could cause a DS4000 Storage Server failure.

Use this procedure to migrate one or more DS4000 storage expansion enclosures 

containing hard drives which themselves contain configuration data from a 

functioning DS4000 Storage Server configuration to another DS4000 Storage 

Server configuration. 

Attention:  Make additions to the DS4000 Storage Server only while it is powered 

on and in optimal  state. See “Bringing storage subsystems and drive loops into 

optimal state” on page 29 for additional information on how to make this 

determination. You can complete this process while the DS4000 Storage Server is 

receiving I/O from the host server. However, because the drive loops are interrupted 

momentarily during the addition process, schedule the addition to occur during time 

periods of low I/O between the DS4000 storage servers and host servers. 

Review the readme and the IBM  TotalStorage  DS4000  Storage  Manager  installation  

and  support  guides  associated with the operating system environment of the host 

servers that connect to the DS4000 Storage Server for information about any 

operating system-specific restrictions in addition to those detailed in this document. 

You will also find preliminary tasks that you may be required to complete detailed in 

that documentation. IBM  TotalStorage  DS4000  Storage  Manager  installation  and  

support  guides  are located at the following Web site: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

Tip:  Before proceeding with the migration procedure, review and perform the steps 

outlined in Chapter 2, “Prerequisites to adding capacity and hard drive migration,” 

on page 23. 

The procedure for migrating a new DS4000 storage expansion enclosure is as 

follows: 
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Activity 1: Preliminary activities 

Before disconnecting any storage expansion enclosures from a DS4000 Storage 

Server, to ensure a successful migration of your drives to the DS4000 Storage 

Server, perform the following steps: 

__ Step 1.   Verify that both the functioning source and the destination DS4000 

Storage Servers’ controller firmware and NVSRAM are at the levels 

recommended in Table 16 on page 24. 

__ Step 2.   Verify that the firmware of the ESMs in the storage expansion 

enclosures that you plan to migrate are at the levels recommended in 

Table 17 on page 26. 

__ Step 3.   Verify that the firmware of the ESMs in the storage expansion 

enclosures attached to the DS4000 Storage Server to which you will 

migrate your drives is at the levels recommended in Table 17 on page 

26. 

__ Step 4.   If you migrate storage expansion enclosures from a 1 Gbps fibre 

channel environment to a 2 Gbps fibre channel environment, verify that 

the fibre channel hard drives that you plan to migrate are each capable 

of 2 Gbps operation and that you have installed the latest firmware 

enabling them to work properly in a 2 Gbps fibre-channel environment. 

__ Step 5.   Verify that the names of the logical drives that are created using the 

hard drives in the migrated storage expansion enclosures are unique in 

the DS4000 Storage Server to which these storage expansion 

enclosures will migrate. If they are not unique, make any necessary 

changes. 

__ Step 6.   If you migrate the drives to a single controller DS4000 Storage Server 

(for example, DS4300 Storage Server Model 6LU or 6LX), change the 

logical drive’s preferred owner to Controller A using the DS4000 

Storage Manager Client program before taking it offline and removing it 

from the DS4000 Storage Server. To set Controller A as the logical drive 

preferred owner, right-click the logical drive entry in the Subsystem 

Management window and select Change  → Ownership/Preferred  Path  

→ Controller  A.

Activity 2: Deleting partition mappings, remote mirror relationships, 

and flashcopies 

__ Step 1.   In addition to array configuration information, any storage partitioning 

configuration data that may reside on drives you plan to migrate will 

migrate with those drives when installed on another DS4000 Storage 

Server. For this reason, take the following precautions to facilitate the 

migration process and prevent problems in storage partitioning 

configuration data migration. 

a.   If a DS4000 storage partitioning premium feature has been enabled 

both on a drive’s original and destination DS4000 storage servers, 

assure that the defined host ports, hosts, and host group names are 

unique to each DS4000 storage server involved in the migration. 

b.   If you must use identical names on both DS4000 storage servers, 

make the names unique before you perform the drive migration. 

If necessary, customize the storage partitioning information on the 

DS4000 storage server to which you have migrated the drives after you 

complete the migration. 
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__ Step 2.   Delete any flashcopies of logical drives defined in the hard drives that 

you plan to migrate. 

__ Step 3.   Remove any remote mirror relationships that involve the logical drives 

defined on the drives that you plan to migrate.

Activity 3: Preparing and backing up the drives 

__ Step 1.   If the arrays and logical drives involved are not in optimal  state, 

perform the steps necessary to bring these arrays and logical drives to 

their optimal  state before attempting migration. See “Bringing storage 

subsystems and drive loops into optimal state” on page 29 for additional 

information on how to make this determination. 

__ Step 2.   If the drive enclosures that you plan to migrate are not in optimal  state, 

perform the steps necessary to bring them to their optimal  state before 

attempting migration. See “Bringing storage subsystems and drive loops 

into optimal state” on page 29 for additional information on how to make 

this determination. 

__ Step 3.   Perform a backup of the logical drives defined in the storage expansion 

enclosures that you plan to migrate. 

__ Step 4.   Monitor the DS4000 Storage Server event log for any errors in the drive 

loop or its components for several days before migrating storage 

expansion enclosures. 

__ Step 5.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Make sure 

that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, Microsoft 

MSCS service periodically writes to the “Quorum” disk.) 

__ Step 6.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:   

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.

__ Step 7.   Place the arrays defined in the storage expansion enclosures that you 

plan to migrate in offline  state. In the Storage Subsystem 

Management window, right-click on the name of the array and click 

Place  → Offline. 

__ Step 8.   Save the DS4000 storage subsystem profile of the functioning DS4000 

Storage Server configuration to which the migration will occur in a 

location other than that of the logical drives you plan to migrate.

Activity 4: Shutting down and moving the storage expansion unit 

__ Step 1.   Because removing a storage expansion enclosure from a functioning 

DS4000 Storage Server will disrupt its drive loops, shutdown the 

functioning destination DS4000 Storage Server while you remove its 

storage expansion enclosures for reconfiguration. If you cannot 

shutdown the DS4000 Storage Server, carefully reconfigure only one 

drive loop, making sure that the drive loop that you modify is connected 

correctly and in optimal  state before you attempt to reconfigure the 
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other drive loop. For additional information on making this 

determination, see “Bringing storage subsystems and drive loops into 

optimal state” on page 29. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Server controllers because two or more 

drives in the arrays cannot be reached through either drive loop in the 

redundant drive loop pair. 

Perform the following steps to verify that the drive loops are in optimal  

state: 

__ Step a.   Physically trace the actual cable connections making sure 

that connections are properly modified and that the cable 

connectors are firmly inserted into the SFPs or GBICs. 

__ Step b.   Verify that the following LEDs are not lit or briefly flashed in 

the modified drive loop: 

v   ESM Fault 

v   port bypass 

v   ID conflict

__ Step c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there 

are problems in the drive loop and the Loop Initialization 

Primitives (LIPs) are generated by the DS4000 Storage 

Server controller. 

__ Step d.   In the DS4000 Storage Manager Client Subsystem 

Management window, verify that there are no loss  of ESM  

path  redundancy  errors in the storage expansion enclosures 

that are not migrated. 

Do not modify the second drive loop in the redundant drive 

loop pair until you are sure that the first modified drive loop 

is operating optimally.

__ Step 2.   Power down the storage expansion enclosures and move them to the 

DS4000 Storage Server to which you plan to migrate them. 

Notes:  

v   A storage expansion enclosure with 14 drives weighs up to 100 lbs. 

(45 kg). If necessary, remove the drives and other storage expansion 

enclosure components to reduce the weight of the unit for easier 

handling. Mark each drive before removing it in order to return it to 

the same drive slot when you reassemble the components at the 

destination location. 

v   Move drives only in a horizontal position using an appropriate ESD 

bag or container and moving equipment that prevents shock to the 

drives during transit. Never stack drives.

Activity 5: Installing and setting storage expansion unit IDs and 

speeds 

__ Step 1.   Once the storage expansion enclosures and drives are at the location 

of DS4000 Storage Server to which they will be migrated, install them 

into the rack. If the drives were removed during transit, return them to 

the slots from which they were removed, unlatched and no less than 

½-inch away from their full insertion points in the drive slots. If the drives 

were not removed, unlatch and pull them out no less than ½-inch away 

from their full insertion points in the drive slots. 
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__ Step 2.   See Figure 15 on page 38 for an illustration of how to set the enclosure 

ID of the storage expansion enclosures. Each drive enclosure in the 

DS4000 storage subsystem drive loop must have a unique drive 

enclosure ID. In a EXP500 Storage Expansion Unit, there is an 

enclosure ID switch mounted on each of two ESM canisters. Set each 

ESM canister’s enclosure ID switch in the EXP500 drive enclosure to 

the same unique number in the drive loop. In a EXP700 Storage 

Expansion Unit, the only enclosure ID switch is mounted between the 

power supplies. To access the appropriate DS4000  storage  expansion  

unit  installation  and  user’s  guide  for additional information, use the 

following Web link: 

www.storage.ibm.com/disk/fastt/index.html 

Important:  If the DS4000 Storage Server to which you will attach 

migrating hard drives is either a FAStT200 or DS4300 (model 60X or 

60U), the enclosure IDs of additional storage expansion enclosures 

must differ from the FAStT200 or DS4300 storage servers’ enclosure 

IDs. These IDs are normally set to “0” at the factory. 

__ Step 3.   Verify that you set the enclosure speed switch of the DS4400 to the 

correct drive loop speed. 

If the enclosure speed switch was originally set to 1 Gbps, do not 

automatically set it to 2 Gbps unless you are sure that each fibre 

channel hard drive it now contains is capable of 2 Gbps operation and 

that you have installed the latest firmware enabling their operation in a 

2 Gbps fibre-channel environment.

Activity 6: Cabling, powering on, and verifying storage expansion unit 

operation 

__ Step 1.   Insert the SFPs or GBICs only into the ports that you plan to use. Do 

not leave GBICs or SFPs inserted in port slots without connecting them 

to other ports using cables. 

__ Step 2.   Cable the new storage expansion enclosures to the end of the 

functioning storage expansion enclosure drive loop to which you are 

migrating them. 

Add only one enclosure at a time to a functioning drive loop if you 

intend to attach multiple storage expansion enclosures. The cabling 

instructions are illustrated in Figure 16 on page 41. 

The general cabling scheme for DS4000 external drive enclosures is 

described in the IBM  TotalStorage  Fibre  Channel  Cabling  Guide, which 

is available at: 

www-3.ibm.com/pc/support/site.wss/document.do?lndocid=MIGR-
4KELS5 

See also “Storage subsystem loop schemes” on page 12. 

__ Step 3.   Extend one of the drive loops (that is, drive loop A) in a DS4000 

Storage Server redundant drive loop pair by connecting the OUT  port of 

the last storage expansion enclosure to the IN  port of the new storage 

expansion enclosure as shown in Figure 16 on page 41. 

Warning:  Carefully reconfigure only one drive loop at a time, making 

sure that the drive loop that you modify is properly connected and in 

optimal  state before you attempt to reconfigure another drive loop. 

Take this precaution to prevent the arrays from being inadvertently 

failed by the DS4000 Storage Server controllers. This happens when 
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two or more drives in the arrays cannot be reached through either drive 

loop in the redundant drive loop pair. 

__ Step 4.   Power on the newly added storage expansion enclosure unit. 

__ Step 5.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop A, now extended to the new storage expansion enclosure, 

are not lit. Using the DS4000 Storage Manager Client Subsystem 

Management window, verify that the new storage expansion enclosure 

is added and displayed in the Logical/Physical view of the window. 

Correct any errors before proceeding to step 6. For port bypass: 

__ Step a.   Verify that the SFPs and GBICs or cables are in good 

condition. 

__ Step b.   Remove and reinsert SFPs, GBICs and cables. 

__ Step c.   Make sure the new drive expansion enclosure fibre channel 

speed switch is set to the same speed as the existing drive 

expansion enclosures and the DS4000 Storage Server fibre 

channel speed setting. 

__ Step d.   Verify that the ESM is good by physically removing and 

swapping it with the other ESM in the same drive expansion 

enclosure. For enclosure ID conflict, set the drive expansion 

enclosure ID switch to values unique from the current 

settings in the existing drive expansion enclosures and 

storage server.

Call the IBM Help Center in your geography for assistance if the 

problems persist. 

__ Step 6.   In the other drive loop (that is, drive loop B) in a DS4000 Storage 

Server redundant drive loop pair, remove the connection from the 

storage subsystem drive loop port to the OUT  port of the last storage 

expansion enclosure and connect it to the OUT  port of the new drive 

enclosure as shown in Figure 17 on page 42. 

__ Step 7.   Wait a few seconds; verify that the port bypass LEDs of the two ports in 

the connection between the storage subsystem drive loop port and the 

OUT  port of the new drive enclosure are not lit. Using the DS4000 

Storage Manager Client Subsystem Management window, verify that 

the new drive enclosure does not indicate the drive  enclosure  lost  

redundancy  path  error. See the preceding step 5 for possible corrective 

actions, if needed. 

__ Step 8.   In drive loop B, cable the new drive enclosure’s IN  port to the OUT  port 

of the last enclosure in the already functioning storage expansion 

enclosure drive loop as shown in Figure 18 on page 43. 

__ Step 9.   Wait a few seconds; verify that the port bypass LEDs of all of the ports 

in drive loop B to which you have added a new connection are not lit. 

Using the DS4000 Storage Manager Client Subsystem Management 

window, verify that all of the drive enclosures in the DS4000 redundant 

drive loop pair to which the new enclosure was added does not report 

the drive  enclosure  lost  redundancy  path  error.

Activity 7: Inserting hard drives and placing logical drives online 

Note:   When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Server, move all of the hard drives from the first 

DS4000 Storage Server as an independent ’set’ to the destination DS4000 

Storage Server. Before moving hard drives as a ’set’ from subsequent 
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DS4000 storage servers, ensure that all of the hard drives from the previous 

’set’ have been successfully transferred to the destination DS4000 Storage 

Server. If you do not transfer hard drives as ’sets’ to the destination DS4000 

Storage Server, the newly relocated array may not appear in the Subsystem 

Management window. 

__ Step 1.   Insert the drives into the empty drive slots in the new enclosure in pairs. 

Wait until each drive pair has fully spun up and displayed in the 

DS4000 Storage Subsystem Management window before inserting the 

next drive pair. 

__ Step 2.   For each additional enclosure that you that you intend to migrate to the 

functioning drive loop pair, perform Activity 5: Installing and setting 

storage expansion unit IDs and speeds step 1 on page 58 through step 

3 on page 59, Activity 6: Cabling, powering on, and verifying storage 

expansion unit operation step 1 on page 59 through step 9 on page 60, 

and step 1 of this activity. (See Figure 19 on page 45.) When you have 

completed adding enclosures, proceed to step 3. 

__ Step 3.   As the DS4000 Storage Server recognizes the drives, it reads and 

displays the array and logical drive information on the drives in the 

Logical/Physical view of the DS4000 Storage Subsystem Management 

window. The storage subsystem places the array in offline  state until it 

recognizes that you have inserted all of the drives that comprise the 

array. 

__ Step 4.   Once you insert all of the drives and the DS4000 Storage Server 

recognizes them, change the state of the arrays or logical drives to the 

online  state by right-clicking on the array name in the Storage 

Subsystem window and clicking Place  → Online. 

If any of the following conditions persist, contact the IBM Help Center in 

your geography for assistance. 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed  unconfigured drive icon ( 

  

) or the Failed  configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 

v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Attention:  Do not initialize a drive that you want to keep (by 

right-clicking its icon and selecting Initialize  from the pull-down menu) if 

it contains configuration or user data. Initializing any of the drives in a 

defined array causes all hard drives that comprise an array to return to 

the Unconfigured  Capacity  storage pool, deleting their array definitions 

from the DS4000 Storage Server configuration. The user data on such 

drives is lost. 

Result:  Once the arrays are online, they are ready for you to configure 

and map to host servers. You might also then recreate flashcopies and 

remote mirror relationships. 

__ Step 5.   Use the DS4000 Storage Manager program to view the storage 

partitioning definitions and make any necessary corrections. 

__ Step 6.   The DS4000 Storage Server that the drives are migrated from will 

display the logical drives that are defined in these drives as “missing 
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LUNs”. In order to remove these “missing LUNs” entries, right-click on 

each entry and select Delete  from the pull-down menu.
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Chapter  7.  Upgrading  a storage  server  in a functioning  

configuration  

Note:   When migrating hard drives from multiple DS4000 storage servers to a 

single DS4000 Storage Server, move all of the hard drives from the first 

DS4000 Storage Server as an independent ’set’ to the destination DS4000 

Storage Server. Before moving hard drives as a ’set’ from subsequent 

DS4000 storage servers, ensure that all of the hard drives from the previous 

’set’ have been successfully transferred to the destination DS4000 Storage 

Server. If you do not transfer hard drives as ’sets’ to the destination DS4000 

Storage Server, the newly relocated array may not appear in the Subsystem 

Management window. 

This procedure details the steps that are required to upgrade a DS4000 Storage 

Server in a functioning DS4000 configuration. Where either an identical or newer 

DS4000 Storage Server model is involved, this upgrade involves only the 

replacement of the DS4000 storage controller to be upgraded. DS4000 storage 

expansion enclosures that had been attached to drives containing configuration 

data are connected to the new DS4000 Storage Server. The upgraded (original) 

DS4000 Storage Server being replaced will be either scrapped or returned to 

operation (redeployed) at a later date with new drives and/or new storage 

expansion enclosures. Table 18 on page 64 illustrates what DS4000 Storage Server 

models you can use as replacements. 

Preliminary considerations: Server upgrade 

While upgrading a storage server in a functioning configuration, remain aware of 

these important considerations: 

v   Observe proper ESD handling procedures when handling electronic equipment. 

v   IBM assigns premium feature entitlements only to specific DS4000 storage 

servers. In order to enable premium features in a replacement DS4000 Storage 

Server configuration that had been enabled in an original DS4000 Storage Server 

configuration, you must purchase appropriate entitlements for the replacement 

DS4000 Storage Server. In addition, IBM assigns host kits only to specific 

DS4000 storage servers. You must also purchase the appropriate host kits for 

new DS4000 storage servers. 

v   See the appropriate DS4000  storage  controller’s  installation  and  user’s  guide  for 

information on the proper power on or power off sequences.

Note:   The remainder of this topic pertains to the original DS4000 Storage Server 

that is designated for replacement as either the original or old DS4000 

Storage Server. 

This task requires that you shutdown the DS4000 Storage Server configuration. In 

addition, after the upgrade, premium features previously enabled in the original 

DS4000 Storage Server along with the enable-by-default premium features in the 

new DS4000 Storage Server will automatically be placed in Out-of-Compliance  

state. Full data availability is retained, but you must generate new premium feature 

SAFE keys in order to re-enable premium features. You can generate new SAFE 

keys by contacting the IBM Help Center in your geography. Be sure to have the 

necessary proof of purchase. Alternately, you can also generate new SAFE keys by 

using instructions located at the following Web site: 

www.premiumfeatures.com 
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The new DS4000 Storage Server controller identifies itself using a new Worldwide 

Name (WWN) that is different from the WWN used by the original DS4000 Storage 

Server controller. For this reason, additional tasks might be required after the 

upgrade for any host applications or drivers that rely on the WWNs to identify 

logical drives defined in a given DS4000 Storage Server. See your application 

program’s documentation, your driver’s user guide, or related documentation for 

detailed instructions on how to update the WWN of the DS4000 Storage Server in 

the application or driver. Additionally, review the readme file and the related IBM  

TotalStorage  DS4000  Storage  Manager  installation  and  support  guide  for 

information about any preparation tasks required in addition or operating 

system-specific restrictions. IBM  TotalStorage  DS4000  Storage  Manager  installation  

and  support  guides  are located at the following Web site: 

www-1.ibm.com/servers/storage/support/fastt/index.html 

Table 18 associates DS4000 Storage Servers with their supported replacements. 

 Table 18.  DS4000  storage  servers  by their  supported  replacements  

DS4000  Storage  Server  product  

Supported  replacement  DS4000  Storage  Server  

product  

DS4100 DS4100 

FAStT200 FAStT200, FAStT500, DS4400, DS4500 

FAStT500 FAStT500, DS4400, DS4300 (60U/60X) (see 2), 

DS4300 Turbo (60U/60X) (see 2), DS4500 

DS4300 Single Controller (6LU/6LX) DS4300 (6LU/6LX), DS4300 (60U/60X), DS4300 

Turbo (60U/60X) 

DS4300 (60U/60X) DS4300 (60U/60X), DS4300 Turbo (60U/60X), 

DS4400, DS4500 

DS4300 Turbo (60U/60X) DS4300 (60U/60X), DS4300 Turbo (60U/60X), 

DS4400, DS4500 

DS4400 FAStT500 (see 3), DS4300 (60U/60X), DS4300 

Turbo (60U/60X), DS4400, DS4500 

DS4500 FAStT500 (see 3), DS4300 (60U/60X), DS4300 

Turbo (60U/60X), DS4400, DS4500
  

Attention:  

1.   Migration to a DS4300 Storage Server configuration from FAStT500, DS4400 or 

DS4500 Storage Server configurations with more than eight drive expansion 

enclosures will require more than one DS4300 Storage Server. See Table 7 on 

page 1. 

2.   DS4300 and DS4300 Turbo storage servers do not accommodate DS4000 

EXP500 drive expansion enclosures. Do not migrate the EXP500 enclosures in 

FAStT500, DS4400 or DS4500 Storage Server configurations to DS4300 or 

DS4300 Turbo Storage Server configurations. 

3.   Set the DS4000 EXP700 storage expansion enclosure’s speed switch to 1 Gbps 

when migrating from 2 Gbps configurations to a FAStT500 Storage Server 1 

Gbps configuration.
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Preliminary considerations: Firmware behavior during server upgrade 

This section describes technical considerations regarding basic DS4000 Storage 

Server controller firmware behavior during a DS4000 Storage Server upgrade. It 

covers firmware behavior during system upgrade, where a new DS4000 Storage 

Server connects to functioning drives and storage expansion enclosures, as well as 

firmware behavior during system redeployment, where the original (old) DS4000 

Storage Server serves as a logically distinct entity, optionally, using some of the 

drives from the original system. 

DS4000 configuration behavior after upgrade and DS4000 Storage 

Server replacement 

The new DS4000 Storage Server that powers up in a functioning storage expansion 

enclosure configuration as part of the DS4000 Storage Server upgrade process 

impacts the following areas of the DS4000 Storage Server identification and 

premium features: 

1.   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage Server 

prior to the upgrade are not returned when the upgrade is complete. Rather, the 

new DS4000 Storage Server begins to advertise itself using WWNs that are 

based on an embedded unique identifier from its controller blades. This 

statement applies to both the port WWNs and the node WWNs. Consequently, 

any hosts that were aware of the logical drives in the original DS4000 Storage 

Server based on the original DS4000 storage server’s WWN values will likely be 

confused. The data volumes that resided behind the previously known WWNs 

now reside behind a seemingly new device with different WWNs. 

2.   Storage Array Identifier (SAI or SA Identifier): 

The storage array identifier, or SA Identifier, is the identification value used by 

the DS4000 Storage Manager host software (SMclient) to uniquely identify 

managed storage servers. The DS4000 Storage Manager SMclient program 

maintains SA Identifier records of previously discovered storage servers in the 

host resident file, which allows it to retain discovery information in a persistent 

fashion. This identifier is stored on DACstore, and persists across reboots, 

power cycles, and so on. The new DS4000 Storage Server that powers up in a 

functioning storage expansion enclosure configuration as part of the DS4000 

Storage Server upgrade process continues to use the SA Identifier of the 

original DS4000 Storage Server. 

3.   SAFE Premium Feature Identifier (SAFE ID) and Premium Feature Enable 

Status: 

The new DS4000 Storage Server retains the SAFE ID of the original DS4000 

Storage Server. It also retains all of the features previously enabled on the 

original DS4000 Storage Server. The feature states, however, are set to the 

Out-of-Compliance  state. As a result, the system sends alert notices and 

establishes a Needs  Attention  condition. Also, any features that are marked in 

the new controller’s NVSRAM for automatic enablement are enabled, though 

their feature states are also set to Out-of-Compliance. You must re-enable the 

premium features by using premium feature SAFE key files.

Redeployed DS4000 configuration behavior in an original (replaced) 

DS4000 Storage Server 

When you redeploy DS4000 Storage Server hardware in another DS4000 storage 

server’s configuration, identification and premium features of the redeployed system 

behave somewhat differently from information described in “DS4000 configuration 
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behavior after upgrade and DS4000 Storage Server replacement” on page 65. This 

section describes those relevant behavioral differences. 

v   Worldwide Name (WWN): 

The worldwide names that were used by the original DS4000 Storage Server are 

retained on the redeployed system. These values are based on an embedded 

unique identifier from the original DS4000 Storage Server controller blades, and 

are stored in the NVSRAM on each controller board within the controller blade. 

Assuming that both controllers remain fully optimal after the redeployment, they 

recognize the stored value and continue to use it. Consequently, any hosts that 

were aware of the original DS4000 Storage Server, based on its WWN values, 

will likely be confused. The logical drives that used to reside behind the 

previously-known WWNs no longer reside there, because they are now part of 

the new DS4000 Storage Server, which has a different WWN. 

v   Storage Array Identifier or SA Identifier: 

If you return one or more drives that were originally moved from a DS4000 

Storage Server back to the original DS4000 Storage Server configuration before 

it is redeployed, it is possible that the SA Identifier that was used on the original 

DS4000 Storage Server system will also be reused in the redeployed DS4000 

Storage Server configuration. Whether or not this occurs depends on the specific 

selection of transported drives. If certain conditions are met, however, the 

redeployed unit adopts the same SA Identifier that was retained by the new 

DS4000 Storage Server. Otherwise, or in cases in which only new drives are 

used in the redeployed configuration, the redeployed DS4000 Storage Server 

generates a new (and unique) SA Identifier that does not conflict with the one 

that was retained by the upgraded unit. 

If both the new and the redeployed DS4000 Storage Server have the same SA 

Identifier, serious problems will result when you start the DS4000 Storage 

Manager SMclient program. Since there will be two DS4000 storage servers with 

the same SA Identifier, the DS4000 Storage Manager SMclient program will 

respond by arbitrarily selecting either the new or the redeployed DS4000 Storage 

Server. The storage server that the DS4000 Storage Manager SMclient program 

arbitrarily selects will be manageable, and the other storage server will be 

unmanageable. 

v   SAFE Premium Feature Identifier (SAFE ID) 

Premium Feature Enable status: 

If you return any drives from an original DS4000 Storage Server, along with the 

original DS4000 Storage Server controllers, to a redeployed DS4000 

configuration, the SAFE ID of the original DS4000 Storage Server will be 

retained, and all enabled features will remain fully enabled and compliant. 

If you do not move any drives from an original DS4000 Storage Server, it 

generates a new SAFE ID when redeployed, enabling none of the premium 

features from the original system. This new SAFE ID prevents the system from 

using any previously-acquired SAFE key files and re-enabling any premium 

features. In cases where the original DS4000 Storage Server was pre-loaded 

with NVSRAM codes to enable certain premium features, NVSRAM codes are 

cleared from the DS4000 Storage Server when redeployed and powered on for 

the first time. Therefore, premium features that were enabled as standard 

features do not reactivate on the redeployed system. The system retains full data 

availability, but you must generate new premium feature SAFE keys in order to 

re-enable premium features. You can generate new SAFE keys by contacting the 

IBM Help Center in your geography. Be sure to have the necessary proof of 

purchase. Alternately, you can also generate new SAFE keys by using 

instructions located at the following Web site: 
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v   Controller IP addresses: 

When the DS4000 Storage Server controllers were assigned static IP addresses, 

the IP addresses were stored in the NVSRAM of the controller board as well as 

the DACstore on the disks. If the new (replacement) DS4000 Storage Server 

controllers were assigned the same IP addresses as the original (replaced) 

DS4000 Storage Server controllers, network problem will arise when the original 

(replaced) DS4000 Storage Server is eventually redeployed . The problem will 

occur because two devices have the same IP address in the Ethernet network. 

The best practice is to assign new unique IP addresses to new (replacement) 

DS4000 Storage Server controllers instead of using the same IP addresses as 

the DS4000 controllers that they replace.

Upgrading storage servers in functioning DS4000 configurations 

Before you perform the following upgrade procedure, review and perform the steps 

detailed in Chapter 2, “Prerequisites to adding capacity and hard drive migration,” 

on page 23. 

Complete the following activities to upgrade your DS4000 Storage Server: 

Activity 1: Preliminary activities 

Perform the following steps before you disconnect storage expansion enclosures 

from an original DS4000 Storage Server that is being replaced to ensure a 

successful DS4000 Storage Server upgrade. 

__ Step  1.   Verify that the original DS4000 storage server’s controller firmware and 

NVSRAM are at the levels shown in Table 16 on page 24. 

__ Step  2.   Verify that the firmware of the ESMs in the storage expansion 

enclosures is at the levels shown in Table 17 on page 26. 

__ Step  3.   Disable or delete any flashcopies of the logical drives. 

__ Step  4.   Delete any remote mirror relationships. 

__ Step  5.   If the arrays (logical drives) are not in optimal  state, perform the steps 

necessary to bring the arrays (logical drives) into their optimal  state 

before you attempt their migration. See the DS4000  Problem  

Determination  Guide  associated with your particular DS4000 hardware 

model or “Bringing storage subsystems and drive loops into optimal 

state” on page 29 for additional information on how to make this 

determination. 

__ Step  6.   If the drive enclosures are not in optimal  state, perform the steps 

necessary to bring them to optimal  state before attempting migration. 

Perform the following steps to verify that the drive loops are in optimal  

state: 

__ Step a.   Physically trace the actual cable connections making sure 

that connections are properly modified and that the cable 

connectors are firmly inserted into the SFPs or GBICs. 

__ Step b.   Verify that the following LEDs are not lit or briefly flashed 

in the modified drive loop: 

v   ESM fault 

v   port bypass 

v   ID conflict

__ Step c.   Verify that the controller drive loop LED remains lit. If the 

controller drive loop LED becomes unlit momentary, there 
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are problems in the drive loop and the LIPs are generated 

by the DS4000 Storage Server controller. 

__ Step d.   In the DS4000 Storage Manager Client Subsystem 

Management window, verify that there are no loss  of  ESM  

path  redundancy  errors in the drives expansion enclosures 

that are not migrated. 

Do not modify the second drive loop in a redundant drive 

loop pair until you are sure that the first modified drive 

loop is operating optimally. See the DS4000  Problem  

Determination  Guide  associated with your particular 

DS4000 hardware model or “Bringing storage subsystems 

and drive loops into optimal state” on page 29 for 

additional information on how to make this determination.

__ Step  7.   Perform a full backup of the original DS4000 Storage Server and 

schedule it for down time. This is necessary because you must power 

down the DS4000 Storage Server configuration during the upgrade 

procedure. 

__ Step  8.   Save the DS4000 storage subsystem profile of the original DS4000 

Storage Server configuration in a location other than that in which the 

logical drives are defined in the original DS4000 Storage Server 

configuration. 

__ Step  9.   Stop all programs, services or processes in the host servers that 

access the logical drives defined in the migrated hard drives. Make 

sure that there are not any running background programs, services or 

processes that write data to the logical drives. (For example, Microsoft 

MSCS service periodically writes to the “Quorum” disk.) 

__ Step 10.   Unmount the file systems to flush I/O from the server cache to disks. 

Notes:   

a.   In a Microsoft Windows environment, remove the drive letter or the 

mount points of the mapped LUNs instead of unmounting the file 

systems. 

b.   Consult documentation associated with your particular operating 

system for detailed information regarding the Unmount procedure.

__ Step 11.   Place the arrays defined on the DS4000 Storage Server in offline  

state. In the Storage Subsystem Management window, right-click on 

the name of the array and select Place  → Offline. 

__ Step 12.   Retrieve proofs of purchase for both the original and new DS4000 

storage servers and for the additional premium feature entitlements on 

the new and original DS4000 storage servers. IBM support personnel 

will require this information to regenerate premium feature SAFE key 

files that were enabled in the original DS4000 Storage Server for use 

on the new DS4000 Storage Server.

Activity 2: Powering off the original DS4000 Storage Server 

Power down the original DS4000 Storage Server and remove it from the DS4000 

configuration. Do not redeploy this DS4000 Storage Server in the same 

management domain as its upgrade (replacement) DS4000 Storage Server until 

you regenerate its SA identifier using the instructions in “Redeploying the original 

(replaced) DS4000 Storage Server” on page 71.

Note:   See the appropriate DS4000  storage  controller’s  installation  and  user’s  guide  

for details on the correct power off sequence.
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Activity 3: Installing new DS4000 Storage Servers and setting minihub 

speed 

Install the new DS4000 Storage Server. For DS4400 and DS4500 Storage Servers, 

set the drive minihub speed switch to the speed of the storage expansion enclosure 

ports to which they are connected. 

Note:   The DS4300 drive loop port operates only at 2 Gbps. If you migrate storage 

expansion enclosures from a 1 Gbps fibre channel environment to a 2 Gbps 

fibre channel environment, do not automatically change the storage 

expansion enclosure speed settings from 1 Gbps to 2 Gbps. Before you do, 

verify that each fibre channel drive involved is capable of 2 Gbps operation 

and that you have installed the latest firmware enabling them to work 

properly in a 2 Gbps fibre channel environment. 

Important:  If the new DS4000 Storage Server is either a FAStT200 or DS4300 

Storage Server, set the FAStT200 or DS4300 enclosure ID to a value unique from 

other EXP storage expansion enclosures in the fibre channel drive loop. These IDs 

are normally set to “0” at the factory. 

Activity 4: Making connections 

Insert the SFPs or GBICs into the DS4000 Storage Server drive port slots and 

make the connections from the DS4000 Storage Server to the storage expansion 

enclosures. For detailed information, see the appropriate DS4000  storage  

controller’s  installation  and  user  guide. 

Activity 5: Powering on the expansion unit and setting IP addresses 

__ Step 1.   Verify that all of the storage expansion enclosures are powered on and 

in optimal  state by examining the expansion enclosure LED states. 

Then, power on the new DS4000 Storage Server. Using the DS4000 

Storage Manager client program, verify that the DS4000 Storage Server 

is operational and that all of the drives are recognized and in optimal  

state. See the DS4000  Problem  Determination  Guide  associated with 

your particular DS4000 hardware model or “Bringing storage 

subsystems and drive loops into optimal state” on page 29 for additional 

information on how to make this determination.

Notes:   

a.   Your storage subsystem will identify the new DS4000 Storage 

Server as the machine type it replaced until you download the 

appropriate NVSRAM file for the new storage server. For example, if 

you replace a FAStT500 with a DS4500, the DS4500 will be 

reported as a FAStT500 until you download the appropriate 

NVSRAM file for the DS4500. 

b.   See the appropriate DS4000  storage  controller’s  installation  and  

user  guide  for information on the proper power on sequence.

__ Step 2.   If the new DS4000 Storage Server is managed out-of-band, perform the 

steps for setting the IP addresses for new DS4000 Storage Server 

controllers defined in the IBM  TotalStorage  DS4000  Storage  Manager  

installation  and  support  guide  associated with your operating system 

environment. DS4000  Storage  Manager  installation  and  support  guides  

are located at the following Web site: 

www-1.ibm.com/servers/storage/support/fastt/index.html

 

 

Chapter 7. Upgrading a storage server in a functioning configuration 69

http://www-1.ibm.com/servers/storage/support/fastt/index.html


Changing DS4000 Storage Server IP addresses 

__ Step  1.   Open the Storage Manager client program’s Enterprise Management 

window.

Note:   The new DS4000 Storage Server will have the same IP 

addresses as the DS4000 Storage Server previously removed. 

__ Step  2.   Select the entry of the DS4000 storage subsystem that you want to 

manage. 

__ Step  3.   Right click and select Manage  Device  from the pop-up menu. The 

DS4000 Storage Manager Client Subsystem Management window 

opens. 

__ Step  4.   In the Logical/Physical view of the window, select Controller  → 

Change  → Network  Configuration. The Change Network 

Configuration window opens. 

__ Step  5.   Select the Slot  A  tab. 

__ Step  6.   Select the radio button labeled Specify  Configuration  Setting. 

__ Step  7.   Type in the new IP address, subnet mask, and gateway information. 

__ Step  8.   Click OK. 

__ Step  9.   Select the Slot  B  tab. 

__ Step 10.   Select the radio button labeled Specify  Configuration  Setting. 

__ Step 11.   Type in the new IP address, subnet mask, and gateway information. 

__ Step 12.   Click OK  to enable the IP address changes. 

__ Step 13.   Close the DS4000 Storage Manager Client Subsystem Management 

window. 

__ Step 14.   Select the entry of the DS4000 storage subsystem whose IP address 

you just changed. Right click. 

__ Step 15.   Select Remove  Device  from the pop-up menu. 

__ Step 16.   Click Yes  to confirm removal of each device. 

__ Step 17.   Select Edit  → Add  Device. The Add Device window opens. 

__ Step 18.   Type in the name or new IP address of controller A and close the 

window. 

__ Step 19.   Type in the name or new IP address of controller B and close the 

window.

Activity 6: Downloading firmware and NVSRAM and returning arrays 

online 

__ Step 1.   Use the DS4000 Storage Manager client program to download the 

firmware and the NVSRAM for the new DS4000 Storage Server. 

__ Step 2.   Return the offline arrays to online  state by right-clicking on the array 

and selecting Place  → Online. If any of the following conditions persist, 

contact the IBM Help Center in your geography for assistance: 

v   The empty drive slot icon ( 

  

) displayed for the drive slot into which 

you inserted the migrating drive. 

v   The Failed  unconfigured drive icon ( 

  

) or the Failed  configured 

drive icon ( 

  

) displayed for the drive slot into which you inserted 

the migrating drive. 
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v   Array configuration data on the drives you have added is incomplete. 

v   You cannot bring the array online.

Activity 7: Generating and applying premium feature SAFE key files 

Generate the new premium feature SAFE key files using the new DS4000 Storage 

Server Feature Enable Identifier. Apply premium feature SAFE keys to remove 

Out-of-Compliance  errors on enabled premium features. 

Result:  You are now able to recreate flashcopies and remote mirror relationships, if 

required. 

Redeploying the original (replaced) DS4000 Storage Server 

As a safety measure, force generation of a new SA Identifier when you redeploy an 

original (replaced) DS4000 Storage Server. Use the controller shell commands to 

generate a new SA Identifier. To gain access to the controller shell, you will require 

a null modem cable and a terminal emulation program that is capable of sending a 

BREAK  signal. The setting for the terminal emulation session is 8-N-1  (8 data bits, no 

parity bit and 1 stop bit). Once you enter the controller shell, use the following 

command sequence to force the controller to generate a new SA Identifier: 

ld  </Debug  

symbolGenerateNewSAIdentifier  

Note:   It is necessary for you to run this command sequence on only one controller.
Then, reset both DS4000 Storage Server controllers and proceed with the normal 

DS4000 Storage Server installation and configuration process. 

Accessing the DS4000 Storage Server controller shell 

The following steps describe how to access the DS4000 Storage Server controller 

shell using the terminal emulation program of your choice. One example of such a 

terminal emulation program for which IBM neither makes nor implies a warranty, 

HyperTerminal, Private Edition; version 6.3 or higher, is available for your 

consideration at the following Web site: 

www.hilgraeve.com 

A generic version of steps involved in accessing the DS4000 Storage Server 

controller shell using the terminal emulation program of your choice follows: 

__ Step  1.   Stop all I/O on the DS4000 Storage Server. 

__ Step  2.   Connect a null modem serial cable from one of the DS4000 Storage 

Server controller communications (COM) ports to a system with an 

available terminal emulator. 

__ Step  3.   Open the terminal emulation program of your choice, such as the 

HyperTerminal, Private Edition program and from the menu bar, click 

File  → Properties  → Configure. Establish the following property 

settings: 

v   Bits per second: 57600 

v   Data bits: 8 

v   Parity: None 

v   Stop Bit: 1 

v   Flow Control: None
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__ Step  4.   Connect to the DS4000 Storage Server controller shell by sending a 

BREAK  signal. (If you are using the HyperTerminal, Private Edition 

program, press the Ctrl  and BREAK  keys simultaneously to send the 

BREAK  signal.) 

__ Step  5.   Repeat step 4 until the following message displays: 

“Press  the  space  bar  for  baud  rate  within  5 seconds.” 

__ Step  6.   Press the space bar within the time limit to establish the correct baud 

rate setting. 

__ Step  7.   Send another BREAK  signal. The following message is displayed: 

“Press  within  5 seconds: ESC  for  SHELL,  BREAK  for  baud  rate.” 

__ Step  8.   Press the ESC  key within the time limit to access the controller shell. 

__ Step  9.   When prompted, type the following password: 

infiniti  

__ Step 10.   You are now accessing the DS4000 Storage Server controller shell. 

Important:  Be careful when entering commands in the DS4000 

Storage Server controller shell. Improper use of DS4000 Storage 

Server controller shell commands could result in loss of configuration 

data.

 

 

72 Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Notices  

This publication was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 

other countries. Consult your local IBM representative for information on the 

products and services currently available in your area. Any reference to an IBM 

product, program, or service is not intended to state or imply that only that IBM 

product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be 

used instead. However, it is the user’s responsibility to evaluate and verify the 

operation of any non-IBM product, program, or service. 

IBM® may have patents or pending patent applications covering subject matter 

described in this document. The furnishing of this document does not give you any 

license to these patents. You can send license inquiries, in writing, to: 

   IBM  Director  of Licensing  

   IBM  Corporation  

   North  Castle  Drive  

   Armonk,  NY  10504-1785  

   U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 

PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or 

implied warranties in certain transactions, therefore, this statement may not apply to 

you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. IBM may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any 

time without notice. 

Any references in this publication to non-IBM Web sites are provided for 

convenience only and do not in any manner serve as an endorsement of those 

Web sites. The materials at those Web sites are not part of the materials for this 

IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 

appropriate without incurring any obligation to you. 

Trademarks  

The following terms are trademarks of International Business Machines Corporation 

in the United States, other countries, or both: 

 FlashCopy Netfinity 

IBM ServerProven 

IBMLink TotalStorage
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Intel is a trademark of Intel Corporation in the United States, other countries, or 

both. 

Java and all Java-based trademarks and logos are trademarks or registered 

trademarks of Sun Microsystems, Inc. in the United States, other countries, or both. 

Other company, product, or service names may be trademarks or service marks of 

others. 

Important notes 

Processor speeds indicate the internal clock speed of the microprocessor; other 

factors also affect application performance. 

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often 

less than the maximum possible. 

When referring to processor storage, real and virtual storage, or channel volume, 

KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000 

bytes, and GB stands for approximately 1 000 000 000 bytes. 

When referring to hard disk drive capacity or communications volume, MB stands 

for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible 

capacity may vary depending on operating environments. 

Maximum internal hard disk drive capacities assume the replacement of any 

standard hard disk drives and population of all hard disk drive bays with the largest 

currently supported drives available from IBM. 

Maximum memory may require replacement of the standard memory with an 

optional memory module. 

IBM makes no representation or warranties regarding non-IBM products and 

services that are ServerProven®, including but not limited to the implied warranties 

of merchantability and fitness for a particular purpose. These products are offered 

and warranted solely by third parties. 

IBM makes no representations or warranties with respect to non-IBM products. 

Support (if any) for the non-IBM products is provided by the third party, not IBM. 

Some software may differ from its retail version (if available), and may not include 

user manuals or all program functionality. 

Electronic emission notices 

This section gives the electronic emission notices or statements for the United 

States and other countries or regions. 

Federal Communications Commission (FCC) statement 

Note:  This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference when the 

equipment is operated in a commercial environment. This equipment generates, 

uses, and can radiate radio frequency energy and, if not installed and used in 

accordance with the instruction manual, may cause harmful interference to radio 
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communications. Operation of this equipment in a residential area is likely to cause 

harmful interference, in which case the user will be required to correct the 

interference at his own expense. 

Properly shielded and grounded cables and connectors must be used in order to 

meet FCC emission limits. Properly shielded and grounded cables and connectors 

must be used in order to meet FCC emission limits.IBM is not responsible for any 

radio or television interference caused by using other than recommended cables 

and connectors or by using other than recommended cables and connectors or by 

unauthorized changes or modifications to this equipment. Unauthorized changes or 

modifications could void the user’s authority to operate the equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and (2) 

this device must accept any interference received, including interference that may 

cause undesired operation. 

Chinese class A compliance statement 

Attention:   This is a class A statement. In a domestic environment, this product 

might cause radio interference in which case the user might be required to take 

adequate measures. 

  

 

Industry Canada Class A emission compliance statement 

This Class A digital apparatus complies with Canadian ICES-003. 

Avis  de  conformité  à la réglementation  d’Industrie  Canada  

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 

Canada. 

Australia and New Zealand Class A statement 

Attention:   This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

United Kingdom telecommunications safety requirement 

Notice  to  Customers  

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect 

connection to public telecommunication systems in the United Kingdom. 

European Union EMC Directive conformance statement 

This product is in conformity with the protection requirements of EU Council 

Directive 89/336/EEC on the approximation of the laws of the Member States 

relating to electromagnetic compatibility. IBM cannot accept responsibility for any 
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failure to satisfy the protection requirements resulting from a nonrecommended 

modification of the product, including the fitting of non-IBM option cards. 

This product has been tested and found to comply with the limits for Class A 

Information Technology Equipment according to CISPR 22/European Standard EN 

55022. The limits for Class A equipment were derived for commercial and industrial 

environments to provide reasonable protection against interference with licensed 

communication equipment. 

 Attention:    This is a Class A product. In a domestic environment this product may 

cause radio interference in which case the user may be required to take adequate 

measures. 

Taiwan  Class A warning statement 

  

 

Japanese Voluntary  Control Council for Interference (VCCI) statement 
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Glossary  

This glossary provides definitions for the 

terminology and abbreviations used in IBM 

TotalStorage DS4000 publications. 

If you do not find the term you are looking for, see 

the IBM  Glossary  of  Computing  Terms  located at 

the following Web site: 

www.ibm.com/ibm/terminology 

This glossary also includes terms and definitions 

from: 

v   Information  Technology  Vocabulary  by 

Subcommittee 1, Joint Technical Committee 1, 

of the International Organization for 

Standardization and the International 

Electrotechnical Commission (ISO/IEC 

JTC1/SC1). Definitions are identified by the 

symbol (I) after the definition; definitions taken 

from draft international standards, committee 

drafts, and working papers by ISO/IEC 

JTC1/SC1 are identified by the symbol (T) after 

the definition, indicating that final agreement 

has not yet been reached among the 

participating National Bodies of SC1. 

v   IBM  Glossary  of  Computing  Terms. New York: 

McGraw-Hill, 1994.

The following cross-reference conventions are 

used in this glossary: 

See  Refers you to (a) a term that is the 

expanded form of an abbreviation or 

acronym, or (b) a synonym or more 

preferred term. 

See  also  

Refers you to a related term.

Abstract  Windowing  Toolkit (AWT).   A Java graphical 

user interface (GUI). 

accelerated  graphics  port  (AGP).   A bus specification 

that gives low-cost 3D graphics cards faster access to 

main memory on personal computers than the usual 

peripheral component interconnect (PCI) bus. AGP 

reduces the overall cost of creating high-end graphics 

subsystems by using existing system memory. 

access  volume.   A special logical drive that allows the 

host-agent to communicate with the controllers in the 

storage subsystem. 

adapter.   A printed circuit assembly that transmits user 

data input/output (I/O) between the internal bus of the 

host system and the external fibre-channel (FC) link and 

vice versa. Also called an I/O adapter, host adapter, or 

FC adapter. 

advanced  technology  (AT) bus  architecture.   A bus 

standard for IBM compatibles. It extends the XT bus 

architecture to 16 bits and also allows for bus 

mastering, although only the first 16 MB of main 

memory are available for direct access. 

agent.   A server program that receives virtual 

connections from the network manager (the client 

program) in a Simple Network Management 

Protocol-Transmission Control Protocol/Internet Protocol 

(SNMP-TCP/IP) network-managing environment. 

AGP.   See accelerated  graphics  port. 

AL_PA.  See arbitrated  loop  physical  address. 

arbitrated  loop.   One of three existing fibre-channel 

topologies, in which 2 - 126 ports are interconnected 

serially in a single loop circuit. Access to the Fibre 

Channel-Arbitrated Loop (FC-AL) is controlled by an 

arbitration scheme. The FC-AL topology supports all 

classes of service and guarantees in-order delivery of 

FC frames when the originator and responder are on 

the same FC-AL. The default topology for the disk array 

is arbitrated loop. An arbitrated loop is sometimes 

referred to as a Stealth Mode. 

arbitrated  loop  physical  address  (AL_PA).   An 8-bit 

value that is used to uniquely identify an individual port 

within a loop. A loop can have one or more AL_PAs. 

array.  A set of fibre-channel hard drives that are 

logically grouped together to form a redundant array of 

independent disks (RAID) set. 

asynchronous  write  mode.   In remote mirroring, an 

option that allows the primary controller to return a write 

I/O request completion to the host server before data 

has been successfully written by the secondary 

controller. See also synchronous  write  mode, remote  

mirroring, Global  Copy,Global  Mirroring. 

AT.  See advanced  technology  (AT) bus  architecture. 

ATA.  See AT-attached. 

AT-attached.   Peripheral devices that are compatible 

with the original IBM AT computer standard in which 

signals on a 40-pin AT-attached (ATA) ribbon cable 

followed the timings and constraints of the Industry 

Standard Architecture (ISA) system bus on the IBM PC 

AT computer. Equivalent to integrated drive electronics 

(IDE). 
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auto-volume  transfer/auto-disk  transfer  (AVT/ADT).   

A function that provides automatic failover in case of 

controller failure on a storage subsystem. 

AVT/ADT.   See auto-volume  transfer/auto-disk  transfer. 

AWT.   See Abstract  Windowing  Toolkit. 

basic  input/output  system  (BIOS).   The personal 

computer code that controls basic hardware operations, 

such as interactions with diskette drives, hard disk 

drives, and the keyboard. 

BIOS.   See basic  input/output  system. 

BOOTP.   See bootstrap  protocol. 

bootstrap  protocol  (BOOTP).   In Transmission Control 

Protocol/Internet Protocol (TCP/IP) networking, an 

alternative protocol by which a diskless machine can 

obtain its Internet Protocol (IP) address and such 

configuration information as IP addresses of various 

servers from a BOOTP server. 

bridge.   A storage area network (SAN) device that 

provides physical and transport conversion, such as 

fibre channel to small computer system interface (SCSI) 

bridge. 

bridge  group.   A bridge and the collection of devices 

connected to it. 

broadcast.   The simultaneous transmission of data to 

more than one destination. 

cathode  ray  tube  (CRT).   A display device in which 

controlled electron beams are used to display 

alphanumeric or graphical data on an 

electroluminescent screen. 

client.   A computer system or process that requests a 

service of another computer system or process that is 

typically referred to as a server. Multiple clients can 

share access to a common server. 

command.   A statement used to initiate an action or 

start a service. A command consists of the command 

name abbreviation, and its parameters and flags if 

applicable. A command can be issued by typing it on a 

command line or selecting it from a menu. 

community  string.   The name of a community 

contained in each Simple Network Management 

Protocol (SNMP) message. 

concurrent  download.   A method of downloading and 

installing firmware that does not require the user to stop 

I/O to the controllers during the process. 

CRC.   See cyclic  redundancy  check. 

CRT.   See cathode  ray  tube. 

CRU.   See customer  replaceable  unit. 

customer  replaceable  unit  (CRU).   An assembly or 

part that a customer can replace in its entirety when any 

of its components fail. Contrast with field  replaceable  

unit  (FRU). 

cyclic  redundancy  check  (CRC).   (1) A redundancy 

check in which the check key is generated by a cyclic 

algorithm. (2) An error detection technique performed at 

both the sending and receiving stations. 

dac.   See disk  array  controller. 

dar.  See disk  array  router. 

DASD.   See direct  access  storage  device. 

default  host  group.   A logical collection of discovered 

host ports, defined host computers, and defined host 

groups in the storage-partition topology that fulfill the 

following requirements: 

v   Are not involved in specific logical drive-to-LUN 

mappings 

v   Share access to logical drives with default logical 

drive-to-LUN mappings

device  type.   Identifier used to place devices in the 

physical map, such as the switch, hub, or storage. 

DHCP.   See Dynamic  Host  Configuration  Protocol. 

direct  access  storage  device  (DASD).   A device in 

which access time is effectively independent of the 

location of the data. Information is entered and retrieved 

without reference to previously accessed data. (For 

example, a disk drive is a DASD, in contrast with a tape 

drive, which stores data as a linear sequence.) DASDs 

include both fixed and removable storage devices. 

direct  memory  access  (DMA).   The transfer of data 

between memory and an input/output (I/O) device 

without processor intervention. 

disk  array  controller  (dac).   A disk array controller 

device that represents the two controllers of an array. 

See also disk  array  router. 

disk  array  router  (dar).   A disk array router that 

represents an entire array, including current and 

deferred paths to all logical unit numbers (LUNs) (hdisks 

on AIX). See also disk  array  controller. 

DMA.   See direct  memory  access. 

domain.   The most significant byte in the node port 

(N_port) identifier for the fibre-channel (FC) device. It is 

not used in the fibre channel-small computer system 

interface (FC-SCSI) hardware path ID. It is required to 

be the same for all SCSI targets logically connected to 

an FC adapter. 

DRAM.   See dynamic  random  access  memory. 
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Dynamic  Host  Configuration  Protocol  (DHCP).   A 

protocol defined by the Internet Engineering Task Force 

that is used for dynamically assigning Internet Protocol 

(IP) addresses to computers in a network. 

dynamic  random  access  memory  (DRAM).   A 

storage in which the cells require repetitive application 

of control signals to retain stored data. 

ECC.   See error  correction  coding. 

EEPROM.   See electrically  erasable  programmable  

read-only  memory. 

EISA.   See Extended  Industry  Standard  Architecture. 

electrically  erasable  programmable  read-only  

memory  (EEPROM).   A type of memory chip which can 

retain its contents without consistent electrical power. 

Unlike the PROM which can be programmed only once, 

the EEPROM can be erased electrically. Because it can 

only be reprogrammed a limited number of times before 

it wears out, it is appropriate for storing small amounts 

of data that are changed infrequently. 

electrostatic  discharge  (ESD).   The flow of current 

that results when objects that have a static charge 

come into close enough proximity to discharge. 

environmental  services  monitor  (ESM)  canister.   A 

component in a drive enclosure that monitors the 

environmental condition of the components in that 

enclosure. Not all storage subsystems have ESM 

canisters. 

E_port.   See expansion  port. 

error  correction  coding  (ECC).   A method for 

encoding data so that transmission errors can be 

detected and corrected by examining the data on the 

receiving end. Most ECCs are characterized by the 

maximum number of errors they can detect and correct. 

ESD.   See electrostatic  discharge. 

ESM  canister.   See environmental  services  monitor  

canister. 

EXP.   See expansion  unit. 

expansion  port  (E_port).   A port that connects the 

switches for two fabrics. 

expansion  unit  (EXP).   A feature that can be 

connected to a system unit to provide additional storage 

and processing capacity. 

Extended  Industry  Standard  Architecture  (EISA).   A 

bus standard for IBM compatibles that extends the 

Industry Standard Architecture (ISA) bus architecture to 

32 bits and allows more than one central processing 

unit (CPU) to share the bus. See also Industry  Standard  

Architecture. 

fabric.   A Fibre Channel entity which interconnects and 

facilitates logins of N_ports attached to it. The fabric is 

responsible for routing frames between source and 

destination N_ports using address information in the 

frame header. A fabric can be as simple as a 

point-to-point channel between two N-ports, or as 

complex as a frame-routing switch that provides multiple 

and redundant internal pathways within the fabric 

between F_ports. 

fabric  port  (F_port).   In a fabric, an access point for 

connecting a user’s N_port. An F_port facilitates N_port 

logins to the fabric from nodes connected to the fabric. 

An F_port is addressable by the N_port connected to it. 

See also fabric. 

DS4000  MSJ.   See DS4000  Management  Suite  Java. 

DS4000  Management  Suite  Java  (DS4000  MSJ).   A 

diagnostic and configuration utility that can be used on 

Linux, Microsoft Windows, and Novell NetWare host 

systems. In Linux, it is also used with the QLRemote 

agent to define preferred and non-preferred paths for 

logical drives. 

FC.   See fibre  channel. 

FC-AL.   See arbitrated  loop. 

feature  enable  identifier.   A unique identifier for the 

storage subsystem, which is used in the process of 

generating a premium feature key. See also premium  

feature  key. 

fibre  channel  (FC).   A set of standards for a serial 

input/output (I/O) bus capable of transferring data 

between two ports at up to 100 Mbps, with standards 

proposals to go to higher speeds. FC supports 

point-to-point, arbitrated loop, and switched topologies. 

Fibre  Channel-Arbitrated  Loop  (FC-AL).   See 

arbitrated  loop. 

Fibre  Channel  Protocol  (FCP)  for  small  computer  

system  interface  (SCSI).   A high-level fibre-channel 

mapping layer (FC-4) that uses lower-level fibre-channel 

(FC-PH) services to transmit SCSI commands, data, 

and status information between a SCSI initiator and a 

SCSI target across the FC link by using FC frame and 

sequence formats. 

field  replaceable  unit  (FRU).   An assembly that is 

replaced in its entirety when any one of its components 

fails. In some cases, a field replaceable unit might 

contain other field replaceable units. Contrast with 

customer  replaceable  unit  (CRU). 

FlashCopy.   A premium feature for DS4000 that can 

make an instantaneous copy of the data in a volume. 

F_port.   See fabric  port. 

FRU.   See field  replaceable  unit. 
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GBIC.   See gigabit  interface  converter  

gigabit  interface  converter  (GBIC).   A transceiver that 

performs serial, optical-to-electrical, and 

electrical-to-optical signal conversions for high-speed 

networking. A GBIC can be hot swapped. See also 

small  form-factor  pluggable. 

Global  Copy.  Refers to a remote logical drive mirror 

pair that is set up using asynchronous write mode 

without the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring without 

Consistency Group.″ Global Copy does not ensure that 

write requests to multiple primary logical drives are 

carried out in the same order on the secondary logical 

drives as they are on the primary logical drives. If it is 

critical that writes to the primary logical drives are 

carried out in the same order in the appropriate 

secondary logical drives, Global Mirroring should be 

used instead of Global Copy. See also asynchronous  

write  mode, Global  Mirroring, remote  mirroring, Metro  

Mirroring. 

Global  Mirroring.   Refers to a remote logical drive 

mirror pair that is set up using asynchronous write mode 

with the write consistency group option. This is also 

referred to as ″Asynchronous Mirroring with Consistency 

Group.″ Global Mirroring ensures that write requests to 

multiple primary logical drives are carried out in the 

same order on the secondary logical drives as they are 

on the primary logical drives, preventing data on the 

secondary logical drives from becoming inconsistent 

with the data on the primary logical drives. See also 

asynchronous  write  mode, Global  Copy, remote  

mirroring, Metro  Mirroring. 

graphical  user  interface  (GUI).   A type of computer 

interface that presents a visual metaphor of a real-world 

scene, often of a desktop, by combining high-resolution 

graphics, pointing devices, menu bars and other menus, 

overlapping windows, icons, and the object-action 

relationship. 

GUI.   See graphical  user  interface.  

HBA.   See host  bus  adapter. 

hdisk.   An AIX term representing a logical unit number 

(LUN) on an array. 

host.   A system that is directly attached to the storage 

subsystem through a fibre-channel input/output (I/O) 

path. This system is used to serve data (typically in the 

form of files) from the storage subsystem. A system can 

be both a storage management station and a host 

simultaneously. 

host  bus  adapter  (HBA).   An interface between the 

fibre-channel network and a workstation or server. 

host  computer.   See host. 

host  group.   An entity in the storage partition topology 

that defines a logical collection of host computers that 

require shared access to one or more logical drives. 

host  port.   Ports that physically reside on the host 

adapters and are automatically discovered by the 

DS4000 Storage Manager software. To give a host 

computer access to a partition, its associated host ports 

must be defined. 

hot  swap.   To replace a hardware component without 

turning off the system. 

hub.   In a network, a point at which circuits are either 

connected or switched. For example, in a star network, 

the hub is the central node; in a star/ring network, it is 

the location of wiring concentrators. 

IBMSAN  driver.   The device driver that is used in a 

Novell NetWare environment to provide multipath 

input/output (I/O) support to the storage controller. 

IC.  See integrated  circuit. 

IDE.   See integrated  drive  electronics. 

in-band.   Transmission of management protocol over 

the fibre-channel transport. 

Industry  Standard  Architecture  (ISA).   Unofficial 

name for the bus architecture of the IBM PC/XT 

personal computer. This bus design included expansion 

slots for plugging in various adapter boards. Early 

versions had an 8-bit data path, later expanded to 16 

bits. The ″Extended Industry Standard Architecture″ 

(EISA) further expanded the data path to 32 bits. See 

also Extended  Industry  Standard  Architecture. 

initial  program  load  (IPL).   The initialization procedure 

that causes an operating system to commence 

operation. Also referred to as a system restart, system 

startup, and boot. 

integrated  circuit  (IC).   A microelectronic 

semiconductor device that consists of many 

interconnected transistors and other components. ICs 

are constructed on a small rectangle cut from a silicon 

crystal or other semiconductor material. The small size 

of these circuits allows high speed, low power 

dissipation, and reduced manufacturing cost compared 

with board-level integration. Also known as a chip. 

integrated  drive  electronics  (IDE).   A disk drive 

interface based on the 16-bit IBM personal computer 

Industry Standard Architecture (ISA) in which the 

controller electronics reside on the drive itself, 

eliminating the need for a separate adapter card. Also 

known as an Advanced Technology Attachment 

Interface (ATA). 
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Internet  Protocol  (IP).   A protocol that routes data 

through a network or interconnected networks. IP acts 

as an intermediary between the higher protocol layers 

and the physical network. 

Internet  Protocol  (IP)  address.   The unique 32-bit 

address that specifies the location of each device or 

workstation on the Internet. For example, 9.67.97.103 is 

an IP address. 

interrupt  request  (IRQ).   A type of input found on 

many processors that causes the processor to suspend 

normal processing temporarily and start running an 

interrupt handler routine. Some processors have several 

interrupt request inputs that allow different priority 

interrupts. 

IP.   See Internet  Protocol. 

IPL.   See initial  program  load. 

IRQ.   See interrupt  request. 

ISA.   See Industry  Standard  Architecture. 

isolated  group.   A collection of isolated devices not 

connected to the storage area network (SAN) but 

discovered by the SANavigator tool. The isolated group 

displays with a gray background near the bottom of the 

Physical and Data Path maps. 

Java  Runtime  Environment  (JRE).   A subset of the 

Java Development Kit (JDK) for end users and 

developers who want to redistribute the Java Runtime 

Environment (JRE). The JRE consists of the Java virtual 

machine, the Java Core Classes, and supporting files. 

JRE.   See Java  Runtime  Environment. 

label.   A discovered or user entered property value that 

is displayed underneath each device in the Physical and 

Data Path maps. 

LAN.   See local  area  network. 

LBA.   See logical  block  address. 

local  area  network  (LAN).   A computer network 

located on a user’s premises within a limited geographic 

area. 

logical  block  address  (LBA).   The address of a logical 

block. Logical block addresses are typically used in 

hosts’ I/O commands. The SCSI disk command 

protocol, for example, uses logical block addresses. 

logical  partition  (LPAR).  (1) A subset of a single 

system that contains resources (processors, memory, 

and input/output devices). A logical partition operates as 

an independent system. If hardware requirements are 

met, multiple logical partitions can exist within a system. 

(2) A fixed-size portion of a logical volume. A logical 

partition is the same size as the physical partitions in its 

volume group. Unless the logical volume of which it is a 

part is mirrored, each logical partition corresponds to, 

and its contents are stored on, a single physical 

partition. (3) One to three physical partitions (copies). 

The number of logical partitions within a logical volume 

is variable. 

logical  unit  number  (LUN).   An identifier used on a 

small computer system interface (SCSI) bus to 

distinguish among up to eight devices (logical units) with 

the same SCSI ID. 

loop  address.   The unique ID of a node in 

fibre-channel loop topology sometimes referred to as a 

loop ID. 

loop  group.   A collection of storage area network 

(SAN) devices that are interconnected serially in a 

single loop circuit. Loop groups are discovered by the 

SANavigator tool and displayed with a gray background 

on the Physical and Data Path maps. 

loop  port.   A node port (N_port) or fabric port (F_port) 

that supports arbitrated loop functions associated with 

an arbitrated loop topology. 

LPAR.  See logical  partition. 

LUN.   See logical  unit  number. 

MAC.   See medium  access  control. 

management  information  base  (MIB).   The 

information that is on an agent. It is an abstraction of 

configuration and status information. 

man  pages.   In UNIX-based operating systems, online 

documentation for operating system commands, 

subroutines, system calls, file formats, special files, 

stand-alone utilities, and miscellaneous facilities. 

Invoked by the man  command. 

MCA.   See micro  channel  architecture. 

media  scan.   A media scan is a background process 

that runs on all logical drives in the storage subsystem 

for which it has been enabled, providing error detection 

on the drive media. The media scan process scans all 

logical drive data to verify that it can be accessed, and 

optionally scans the logical drive data also. 

medium  access  control  (MAC).   In local area 

networks (LANs), the sublayer of the data link control 

layer that supports medium-dependent functions and 

uses the services of the physical layer to provide 

services to the logical link control sublayer. The MAC 

sublayer includes the method of determining when a 

device has access to the transmission medium. 

Metro  Mirroring.   This term is used to refer to a 

remote logical drive mirror pair which is set up with 

synchronous write mode. See also remote  mirroring, 

Global  Mirroring. 

MIB.   See management  information  base. 
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micro  channel  architecture  (MCA).   Hardware that is 

used for PS/2 Model 50 computers and above to 

provide better growth potential and performance 

characteristics when compared with the original 

personal computer design. 

Microsoft  Cluster  Server  (MSCS).   MSCS, a feature 

of Windows NT Server (Enterprise Edition), supports the 

connection of two servers into a cluster for higher 

availability and easier manageability. MSCS can 

automatically detect and recover from server or 

application failures. It can also be used to balance 

server workload and provide for planned maintenance. 

model.   The model identification that is assigned to a 

device by its manufacturer. 

MSCS.   See Microsoft  Cluster  Server. 

network  management  station  (NMS).   In the Simple 

Network Management Protocol (SNMP), a station that 

runs management application programs that monitor 

and control network elements. 

NMI.   See non-maskable  interrupt. 

NMS.   See network  management  station. 

non-maskable  interrupt  (NMI).   A hardware interrupt 

that another service request cannot overrule (mask). An 

NMI bypasses and takes priority over interrupt requests 

generated by software, the keyboard, and other such 

devices and is issued to the microprocessor only in 

disastrous circumstances, such as severe memory 

errors or impending power failures. 

node.   A physical device that allows for the 

transmission of data within a network. 

node  port  (N_port).   A fibre-channel defined hardware 

entity that performs data communications over the 

fibre-channel link. It is identifiable by a unique worldwide 

name. It can act as an originator or a responder. 

nonvolatile  storage  (NVS).   A storage device whose 

contents are not lost when power is cut off. 

N_port.   See node  port. 

NVS.   See nonvolatile  storage. 

NVSRAM.   Nonvolatile storage random access 

memory. See nonvolatile  storage. 

Object  Data  Manager  (ODM).   An AIX proprietary 

storage mechanism for ASCII stanza files that are 

edited as part of configuring a drive into the kernel. 

ODM.   See Object  Data  Manager. 

out-of-band.   Transmission of management protocols 

outside of the fibre-channel network, typically over 

Ethernet. 

partitioning.   See storage  partition. 

PCI  local  bus.   See peripheral  component  interconnect  

local  bus. 

PDF.   See portable  document  format. 

performance  events.   Events related to thresholds set 

on storage area network (SAN) performance. 

peripheral  component  interconnect  local  bus  (PCI  

local  bus).   A local bus for PCs, from Intel, that 

provides a high-speed data path between the CPU and 

up to 10 peripherals (video, disk, network, and so on). 

The PCI bus coexists in the PC with the Industry 

Standard Architecture (ISA) or Extended Industry 

Standard Architecture (EISA) bus. ISA and EISA boards 

plug into an IA or EISA slot, while high-speed PCI 

controllers plug into a PCI slot. See also Industry  

Standard  Architecture, Extended  Industry  Standard  

Architecture. 

polling  delay.  The time in seconds between 

successive discovery processes during which discovery 

is inactive. 

port.   A part of the system unit or remote controller to 

which cables for external devices (such as display 

stations, terminals, printers, switches, or external 

storage units) are attached. The port is an access point 

for data entry or exit. A device can contain one or more 

ports. 

portable  document  format  (PDF).   A standard 

specified by Adobe Systems, Incorporated, for the 

electronic distribution of documents. PDF files are 

compact; can be distributed globally by e-mail, the Web, 

intranets, or CD-ROM; and can be viewed with the 

Acrobat Reader, which is software from Adobe Systems 

that can be downloaded at no cost from the Adobe 

Systems home page. 

premium  feature  key.  A file that the storage 

subsystem controller uses to enable an authorized 

premium feature. The file contains the feature enable 

identifier of the storage subsystem for which the 

premium feature is authorized, and data about the 

premium feature. See also feature  enable  identifier. 

private  loop.   A freestanding arbitrated loop with no 

fabric attachment. See also arbitrated  loop. 

program  temporary  fix (PTF).   A temporary solution or 

bypass of a problem diagnosed by IBM in a current 

unaltered release of the program. 

PTF.   See program  temporary  fix. 

RAID.   See redundant  array  of independent  disks. 

RAM.   See random-access  memory. 
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random-access  memory  (RAM).   A temporary storage 

location in which the central processing unit (CPU) 

stores and executes its processes. Contrast with DASD. 

RDAC.   See redundant  disk  array  controller. 

read-only  memory  (ROM).   Memory in which stored 

data cannot be changed by the user except under 

special conditions. 

recoverable  virtual  shared  disk  (RVSD).   A virtual 

shared disk on a server node configured to provide 

continuous access to data and file systems in a cluster. 

redundant  array  of independent  disks  (RAID).   A 

collection of disk drives that appears as a single volume 

to the server and are fault tolerant through mirroring or 

parity checking. 

redundant  disk  array  controller  (RDAC).   (1) In 

hardware, a redundant set of controllers (either 

active/passive or active/active). (2) In software, a layer 

that manages the input/output (I/O) through the active 

controller during normal operation and transparently 

reroutes I/Os to the other controller in the redundant set 

if a controller or I/O path fails. 

remote  mirroring.   Online, real-time replication of data 

between storage subsystems that are maintained on 

separate media. The Enhanced Remote Mirror Option is 

a DS4000 premium feature that provides support for 

remote mirroring. See also Global  Mirroring, Metro  

Mirroring. 

ROM.   See read-only  memory. 

router.   A computer that determines the path of 

network traffic flow. The path selection is made from 

several paths based on information obtained from 

specific protocols, algorithms that attempt to identify the 

shortest or best path, and other criteria such as metrics 

or protocol-specific destination addresses. 

RVSD.   See recoverable  virtual  shared  disk. 

SAI.   See Storage  Array  Identifier. 

SA  Identifier.   See Storage  Array  Identifier. 

SAN.   See storage  area  network. 

SATA.  See serial  ATA. 

scope.   Defines a group of controllers by their Internet 

Protocol (IP) addresses. A scope must be created and 

defined so that dynamic IP addresses can be assigned 

to controllers on the network. 

SCSI.   See small  computer  system  interface. 

segmented  loop  port  (SL_port).   A port that allows 

division of a fibre-channel private loop into multiple 

segments. Each segment can pass frames around as 

an independent loop and can connect through the fabric 

to other segments of the same loop. 

sense  data.   (1) Data sent with a negative response, 

indicating the reason for the response. (2) Data 

describing an I/O error. Sense data is presented to a 

host system in response to a sense request command. 

serial  ATA.  The standard for a high-speed alternative 

to small computer system interface (SCSI) hard drives. 

The SATA-1 standard is equivalent in performance to a 

10 000 RPM SCSI drive. 

serial  storage  architecture  (SSA).   An interface 

specification from IBM in which devices are arranged in 

a ring topology. SSA, which is compatible with small 

computer system interface (SCSI) devices, allows 

full-duplex packet multiplexed serial data transfers at 

rates of 20 Mbps in each direction. 

server.   A functional hardware and software unit that 

delivers shared resources to workstation client units on 

a computer network. 

server/device  events.   Events that occur on the server 

or a designated device that meet criteria that the user 

sets. 

SFP.   See small  form-factor  pluggable. 

Simple  Network  Management  Protocol  (SNMP).   In 

the Internet suite of protocols, a network management 

protocol that is used to monitor routers and attached 

networks. SNMP is an application layer protocol. 

Information on devices managed is defined and stored 

in the application’s Management Information Base 

(MIB). 

SL_port.   See segmented  loop  port. 

SMagent.   The DS4000 Storage Manager optional 

Java-based host-agent software, which can be used on 

Microsoft Windows, Novell NetWare, HP-UX, and 

Solaris host systems to manage storage subsystems 

through the host fibre-channel connection. 

SMclient.   The DS4000 Storage Manager client 

software, which is a Java-based graphical user interface 

(GUI) that is used to configure, manage, and 

troubleshoot storage servers and expansion units in a 

DS4000 storage subsystem. SMclient can be used on a 

host system or on a storage management station. 

SMruntime.   A Java compiler for the SMclient. 

SMutil.   The DS4000 Storage Manager utility software 

that is used on Microsoft Windows, HP-UX, and Solaris 

host systems to register and map new logical drives to 

the operating system. In Microsoft Windows, it also 

contains a utility to flush the cached data of the 

operating system for a particular drive before creating a 

FlashCopy. 
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small  computer  system  interface  (SCSI).   A standard 

hardware interface that enables a variety of peripheral 

devices to communicate with one another. 

small  form-factor  pluggable  (SFP).   An optical 

transceiver that is used to convert signals between 

optical fiber cables and switches. An SFP is smaller 

than a gigabit interface converter (GBIC). See also 

gigabit  interface  converter. 

SNMP.   See Simple  Network  Management  Protocol  and 

SNMPv1. 

SNMP  time-out.   The maximum amount of time the 

SANavigator tool will wait for a device to respond to a 

request. The specified time applies to one retry only. 

SNMP  trap  event.   (1) (2) An event notification sent by 

the SNMP agent that identifies conditions, such as 

thresholds, that exceed a predetermined value. See 

also Simple  Network  Management  Protocol. 

SNMPv1.   The original standard for SNMP is now 

referred to as SNMPv1, as opposed to SNMPv2, a 

revision of SNMP. See also Simple  Network  

Management  Protocol. 

SRAM.   See static  random  access  memory. 

SSA.   See serial  storage  architecture. 

static  random  access  memory  (SRAM).   Random 

access memory based on the logic circuit know as 

flip-flop. It is called static because it retains a value as 

long as power is supplied, unlike dynamic random 

access memory (DRAM), which must be regularly 

refreshed. It is however, still volatile, meaning that it can 

lose its contents when the power is turned off. 

storage  area  network  (SAN).   A dedicated storage 

network tailored to a specific environment, combining 

servers, storage products, networking products, 

software, and services. See also fabric. 

Storage  Array  Identifier  (SAI  or  SA  Identifier).   The 

Storage Array Identifier is the identification value used 

by the DS4000 Storage Manager host software 

(SMClient) to uniquely identify each managed storage 

server. The DS4000 Storage Manager SMClient 

program maintains Storage Array Identifier records of 

previously-discovered storage servers in the host 

resident file, which allows it to retain discovery 

information in a persistent fashion. 

storage  management  station.   A system that is used 

to manage the storage subsystem. A storage 

management station does not need to be attached to 

the storage subsystem through the fibre-channel 

input/output (I/O) path. 

storage  partition.   Storage subsystem logical drives 

that are visible to a host computer or are shared among 

host computers that are part of a host group. 

storage  partition  topology.   In the DS4000 Storage 

Manager client, the Topology view of the Mappings 

window displays the default host group, the defined host 

group, the host computer, and host-port nodes. The 

host port, host computer, and host group topological 

elements must be defined to grant access to host 

computers and host groups using logical drive-to-LUN 

mappings. 

subnet.   An interconnected but independent segment 

of a network that is identified by its Internet Protocol (IP) 

address. 

sweep  method.   A method of sending Simple Network 

Management Protocol (SNMP) requests for information 

to all the devices on a subnet by sending the request to 

every device in the network. 

switch.   A fibre-channel device that provides full 

bandwidth per port and high-speed routing of data by 

using link-level addressing. 

switch  group.   A switch and the collection of devices 

connected to it that are not in other groups. Switch 

groups are discovered by the SANavigator tool and 

displayed with a gray background on the Physical and 

Data Path maps. 

switch  zoning.   See zoning. 

synchronous  write  mode.   In remote mirroring, an 

option that requires the primary controller to wait for the 

acknowledgment of a write operation from the 

secondary controller before returning a write I/O request 

completion to the host. See also asynchronous  write  

mode, remote  mirroring, Metro  Mirroring. 

system  name.   Device name assigned by the vendor’s 

third-party software. 

TCP.   See Transmission  Control  Protocol. 

TCP/IP.   See Transmission  Control  Protocol/Internet  

Protocol. 

terminate  and  stay  resident  program  (TSR  

program).   A program that installs part of itself as an 

extension of DOS when it is executed. 

topology.   The physical or logical arrangement of 

devices on a network. The three fibre-channel 

topologies are fabric, arbitrated loop, and point-to-point. 

The default topology for the disk array is arbitrated loop. 

TL_port.   See translated  loop  port. 

transceiver.   A device that is used to transmit and 

receive data. Transceiver is an abbreviation of 

transmitter-receiver. 

translated  loop  port  (TL_port).   A port that connects 

to a private loop and allows connectivity between the 

private loop devices and off loop devices (devices not 

connected to that particular TL_port). 
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Transmission  Control  Protocol  (TCP).   A 

communication protocol used in the Internet and in any 

network that follows the Internet Engineering Task Force 

(IETF) standards for internetwork protocol. TCP 

provides a reliable host-to-host protocol between hosts 

in packed-switched communication networks and in 

interconnected systems of such networks. It uses the 

Internet Protocol (IP) as the underlying protocol. 

Transmission  Control  Protocol/Internet  Protocol  

(TCP/IP).   A set of communication protocols that 

provide peer-to-peer connectivity functions for both local 

and wide-area networks. 

trap.   In the Simple Network Management Protocol 

(SNMP), a message sent by a managed node (agent 

function) to a management station to report an 

exception condition. 

trap  recipient.   Receiver of a forwarded Simple 

Network Management Protocol (SNMP) trap. 

Specifically, a trap receiver is defined by an Internet 

Protocol (IP) address and port to which traps are sent. 

Presumably, the actual recipient is a software 

application running at the IP address and listening to 

the port. 

TSR  program.   See terminate  and  stay  resident  

program. 

uninterruptible  power  supply.  A source of power 

from a battery that is installed between a computer 

system and its power source. The uninterruptible power 

supply keeps the system running if a commercial power 

failure occurs, until an orderly shutdown of the system 

can be performed. 

user  action  events.   Actions that the user takes, such 

as changes in the storage area network (SAN), changed 

settings, and so on. 

vendor.   Property value that the SANavigator tool uses 

to launch third-party software. Vendor property might be 

discovered, but will always remain editable. 

worldwide  name  (WWN).   A unique identifier for a 

switch on local and global networks. 

WORM.   See write-once  read-many. 

write-once  read  many  (WORM).   Any type of storage 

medium to which data can be written only a single time, 

but can be read from any number of times. After the 

data is recorded, it cannot be altered. 

WWN.   See worldwide  name. 

zoning.   (1) In Fibre Channel environments, the 

grouping of multiple ports to form a virtual, private, 

storage network. Ports that are members of a zone can 

communicate with each other, but are isolated from 

ports in other zones. (2) A function that allows 

segmentation of nodes by address, name, or physical 

port and is provided by fabric switches or hubs.
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A
access controller shell 71 

add
new hard drives 31 

single drive enclosure
final connection 42 

first connection 40 

second connection 41 

storage expansion enclosures 37 

storage expansion units
license requirement 1 

used hard drives 31 

AppWare 24 

array
cannot bring online 51 

configuration data for drives incomplete 51 

RAID-level modification 29 

redundancy checking 29 

return online 70 

arrays, migrating 51 

attention 31, 32, 37, 45, 51, 55, 57, 61 

automatically reset controllers 32, 33, 44, 46 

B
backup

logical drives 48, 57 

storage server data 23, 68 

bag or container, ESD 63 

BootWare 24 

C
cable

connections 41, 42 

EXP500 to EXP700 5 

EXP700 to EXP500 5 

new storage expansion enclosures 39 

trace connections 58, 67 

cabling instructions xvi 

cabling, incorrect 12 

cannot bring array online 51 

catastrophic failure 30 

change fibre channel speed settings 4 

change storage server IP address 70 

check drive firmware level 28, 29 

check for configuration data 32 

on newly discovered drives 46 

Class A electronic emission notice 74 

clear configuration data 44 

complete SM SW installation xvi 

compliant state 66 

concepts guide xvi 

Concepts Guide xxii 

configuration
behavior after replacement 65 

data, clear 44 

configuration data 47 

configure drives 33 

configure storage hardware xvi 

configure storage subsystems on host xvi 

connect power xvi 

container or bag, ESD 63 

controller
blade, embedded unique identifier 66 

drive loop LED 58, 67 

firmware download during I/O 26 

firmware version 23 

by machine type 24 

by model number 24 

by NVSRAM version 24 

current 25 

firmware, verify level 23, 25, 48, 56, 67 

reset automatically 32, 33, 44, 46 

shell, accessing 71 

controller IP addresses 67 

Copy Services Guide xxii 

copyback, logical drive 29 

customize storage partitioning information 48, 56 

D
DACstore 65, 67 

DCE 29 

delete
FlashCopy 56 

remote mirror relationships 57 

storage partition mappings 56 

determine management method xvi 

disable drive migration settings 32, 43 

become effective 32 

DisableDriveMigration.scr script 34 

documentation
DS4000 Storage Manager xxii 

related xxi 

downloading drive firmware 26 

drive displays as unconfigured 45 

drive expansion enclosure weight 58 

drive firmware
downloading 26 

drive firmware download 26 

drive firmware, level 28, 29 

drive loop
optimal state 29 

pairs, maximum allowable 1 

speed change procedure 4 

drive loop pairs, maximum 6 

drive loop state, determine 23 

drive loops A and B 39, 40, 59, 60 

drive migration
prerequisites 23 

settings
disable 31, 43 

enable 45 

re-enable 32, 44 
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drives
CRU assembly 49 

do not appear marked as Failed 51 

do not display 51 

maximum allowable 1 

remove
configuration data 31 

will not spin up 31, 37, 47 

DS4000 Problem Determination Guide 67 

DS4000 Storage Manager
related documents xxi 

DS4000 Storage Manager 9
user tasks xxii 

DS4000 Storage Manager publications 21 

DS4000 Storage Server
firmware 24 

NVSRAM 24 

profile 23 

DS4000 support
Web site 25 

DS4100 Storage Server library xix 

DS4300
1 Gbps fibre channel drives 37 

enclosure IDs 38 

Storage Server firmware and NVSRAM 24 

Turbo Storage Server firmware and NVSRAM 24 

DS4300 Fibre Channel Storage Server library xix 

DS4400 Storage Server firmware and NVSRAM 24 

DS4400 Storage Server library xviii 

DS4500 Fibre Channel Storage Server library xvi 

DS4500 Storage Server firmware and NVSRAM 24 

DVE 29 

dynamic
capacity expansion, DCE 29 

volume expansion, DVE 29 

E
electronic emission Class A notice 74 

Electronic emission notices
Australia and New Zealand Class A statement 75 

European Union EMC Directive conformance 

statement 75 

Federal Communications Commission (FCC) 

statement 74 

Industry Canada Class A emission compliance 

statement 75 

Japanese Voluntary Control Council for Interference 

(VCCI) statement 76 

Taiwanese Class A warning statement 76 

United Kingdom telecommunications safety 

requirement 75 

electrostatic discharge (ESD) procedure 31 

empty drive icon 51 

emulation program, sample 71 

EnableDriveMigration.scr script 32, 33, 46 

enclosure ID 17 

environmental service module (ESM) firmware 5 

errors
drive enclosure lost redundancy path 39, 40, 60 

loss of ESM path redundancy 58, 67 

errors (continued)
management event log (MEL) 23 

out-of-compliance 71 

ESD bag or container 58, 63 

ESM Fault LED 58, 67 

ESM firmware
EXP500 25 

EXP700 25 

upgrade during I/O 24 

version, current 25 

version, upgrade 26 

version, upgrade during I/O 26 

event logs, interpreting 29 

execute script 31, 32, 43, 46 

EXP100
ID settings 18 

EXP500
and EXP700 in a redundant drive loop pair 3 

cabling 5 

drive loop pair maximum 6 

ESM firmware 25 

ID settings 18 

ID switch location 38, 58 

maximum per drive loop pairs 6 

EXP500 and EXP700 enclosure ID settings 19 

EXP700
1 Gbps fibre channel drives 37 

and EXP500 in a redundant drive loop pair 3 

cabling 5 

drive loop pair maximum 6 

ESM firmware 25 

ID settings 19 

ID switch location 38, 58 

maximum per drive loop pairs 6 

EXP700 and EXP710 enclosure ID settings 20 

expansion enclosure
ID setting 17 

expansion enclosure and storage server 

compatibility 4 

expansion enclosure compatibility, mixed 3 

expansion enclosure speed setting 64, 69 

expansion enclosures
cabling mixed 5 

ESM firmware version 25 

ID setting 38, 58, 69 

LED state 69 

migrate 55 

speeds restriction 3 

expansion unit enclosure speed setting 59 

expansion units
ID setting 58 

migrate 55 

F
Failed icons 51 

false storage server identification, example 69 

FAStT200
enclosure IDs 38 

HA Storage Server firmware and NVSRAM 24 

Storage Server firmware and NVSRAM 24 
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FAStT500 RAID Controller Enclosure firmware and 

NVSRAM 24 

FC cabling instructions xvi 

FC HW maintenance and problem determination 

guide xvi 

FC planning and integration user’s guide and service 

information xvi 

FC storage server installation guide xvi 

FC Worldwide Name (WWN) 63 

FCC Class A notice 74 

fibre channel
connections cabling 41, 42 

drive firmware 26 

insert drives 31, 32, 37, 38, 44, 47, 50, 61 

remove connection 39, 60 

trace cable connections 58, 67 

Worldwide Name (WWN) storage 63, 65, 66 

firmware
compatibility 24 

controller 24 

controller and NVSRAM levels 48, 56 

controller, NVSRAM, and ESM levels 23 

current 24 

download 70 

ESM, version by expansion enclosure 25 

updates 25 

verify controller and NVSRAM levels 67 

firmware and NVSRAM
DS4300

Storage Server 24 

Turbo Storage Server 24 

DS4400 Storage Server 24 

DS4500 Storage Server 24 

FAStT200
HA Storage Server 24 

Storage Server 24 

FAStT500 RAID Controller Enclosure 24 

FlashCopy
delete 48, 56, 67 

recreate 51, 61, 71 

flush I/O 23, 68 

flush server-cached I/O 23 

force generation SA Identifier 71 

G
GBIC 39, 58, 59, 67, 69 

generate
new premium feature SAFE keys 63, 71 

SA Identifier 71 

gigabit interface converter 39, 58, 59, 67, 69 

glossary 77 

H
hard drives

add new 31 

add storage expansion enclosures containing 37 

add used 31 

ID/Model Number 31, 37, 47 

migrate 47 

hard drives (continued)
newly discovered 44 

prerequisites 23 

removal 49 

will not spin up 31, 37, 47 

hardware installation process xvi 

hardware maintenance and problem determination xvi 

HBA installation and user’s guide xvi 

help
center 29 

online 30 

prevent data loss 30 

host bus adapter installation and user’s guide xvi 

host group names, unique 48, 56 

host kits, purchase 65 

host names, unique 48, 56 

host ports, unique 48, 56 

HyperTerminal, Private Edition 71 

I
I/O, flush 23, 68 

IBM
Help Center, contact 29 

IBMSAN.CDM multi-path software 26 

icon
empty drive 51 

Failed 51, 61, 70 

Subsystem Management window 51, 61, 70 

ID
conflict LED 58, 67 

switch location 38 

ID/model number, hard drive 31, 37, 47 

identify
1 Gbps FC drives 31, 37, 47 

firmware updates 25 

ignore
configuration data setting 31 

configuration information 43 

impact of new storage server
on identification 65 

on premium features 65 

IN port 39, 40, 59, 60 

incorrect cabling schemes 12 

initialize a drive 61 

insert drives 44, 61 

insert fibre channel drives 50 

insert SATA drives 50 

install and verify SM SW on host and workstation xvi 

install network hardware xvi 

install storage expansion unit xvi 

install storage server/RAID enclosures in rack xvi 

installation and support OS guides xvi 

installation guide, storage server xvi 

installation planning xvi 

installation process xvi 

intermix expansion units 3 

intermixed enclosure ID settings 19, 20 

intermixing EXP500s and EXP700s 5 

intermixing EXP700s and EXP710s 6 

IP address, change 70 
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IP addresses 67 

L
LED

controller drive loop 58, 67 

expansion enclosure states 69 

ID conflict 58, 67 

port bypass 58, 67 

license requirements 1 

Linux failover adapter driver
multi-path software 26 

listing
DisableDriveMigration.scr script file 34 

EnableDriveMigration.scr script file 33 

load script 31, 32, 46 

logical drive
backup 48, 57 

copyback 29 

creation, FlashCopy 29 

creation, VolumeCopy 29 

dynamic capacity expansion 29 

flashcopies, delete 48 

reconstruction 29 

segment size modification 29 

sparing 29 

synchronization, remote mirror 29 

verify name 48 

Loop Initialization Primitive (LIP) 58 

loss of ESM path redundancy error 58, 67 

M
machine type 1722

Model 60U 1, 24 

Model 60X 1, 24 

Model 6LU 1, 24 

Model 6LX 1, 24 

machine type 1740
Model 1RU 25 

Model 1RX 25 

machine type 1742
Model 1RU 1, 24 

Model 1RX 1, 24 

Model 90U 1, 24 

Model 90X 1, 24 

machine type 3542
Model 1RU 1, 24 

Model 1RX 1, 24 

Model 2RU 1, 24 

Model 2RX 1, 24 

machine type 3552
Model 1RU 1, 24 

Model 1RX 1, 24 

machine type 3560
Model 1RU 25 

Model 1RX 25 

make FC connections xvi 

management event log errors 23 

map drives 33 

maximum
allowable drives 1 

drive expansion enclosures 6 

drives per redundant drive loop pair 6 

storage expansion enclosures 6 

MEL errors 23 

menu option
Advanced → Reset Controller 32, 33, 46 

Array → Check Redundancy 29 

Execute 44, 46 

Script 32, 46 

File → Load Script 31, 32, 43, 46 

Initialize 51 

Place → Offline 49, 57, 68 

Place → Online 51, 61 

Tools → Verify and Execute 32, 44, 46 

migrate drives 26 

migrate hard drives 47 

migrate storage expansion enclosures with drives 55 

migrating arrays 51 

migration guide xvi 

minihub speed, set 69 

mix expansion enclosures 3 

mix expansion units 3 

mixed configuration
EXP500 to EXP700 cabling 5 

EXP700 to EXP500 cabling 5 

model number
DS4000 EXP500

1RU 25 

1RX 25 

DS4000 EXP700
1RU 25 

1RX 25 

DS4100
100 24 

DS4300
60U 1, 24 

60X 1, 24 

DS4300 Single Controller
6LU 1, 24 

6LX 1, 24 

DS4300 Turbo
60U 1, 24 

60X 1, 24 

DS4400
1RU 1, 24 

1RX 1, 24 

DS4500
90U 1, 24 

90X 1, 24 

FAStT200
1RU 1, 24 

1RX 1, 24 

2RU 1, 24 

2RX 1, 24 

FAStT500
1RU 1, 24 

1RX 1, 24 

move drives 26 
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multi-path software
IBMSAN.CDM 26 

Linux failover adapter driver 26 

RDAC 26 

N
Needs Attention

condition 65 

state 29 

new storage server impact 65 

notes, important 74 

notices
electronic emission 74 

FCC, Class A 74 

null modem serial cable 71 

NVSRAM
clear codes 66 

codes pre-loaded 66 

DS4000 Storage Server 24 

stores IP addresses 67 

verify level 23, 25, 56, 67 

version, by controller firmware version 24 

NVSRAM and controller firmware
DS4300

Storage Server 24 

Turbo Storage Server 24 

DS4400 Storage Server 24 

DS4500 Storage Server 24 

FAStT200
HA Storage Server 24 

Storage Server 24 

FAStT500 RAID Controller Enclosure 24 

O
offline state 51, 57, 61, 68 

online help xvi, 30 

online state 51, 61, 70 

optimal state 23, 29, 37, 47, 48, 51, 55, 57, 67, 69 

OUT port 39, 40, 59, 60 

out-of-band storage server IP addresses 69 

out-of-compliance state 63, 65 

P
port bypass LED 39, 40, 58, 60, 67 

post-replacement configuration behavior 65 

post-upgrade configuration behavior 65 

power on
drive expansion enclosure 4 

storage expansion enclosure 4 

storage server 4 

premium feature
enable status 65, 66 

generate new SAFE keys 63, 71 

IBM assigns entitlements 65 

identifier 65 

impact of new storage server on 65 

re-enable 65 

premium features
enabled as standard 66 

prepare for SM SW installation xvi 

prepare network connection xvi 

prerequisites
adding capacity 23 

drive migration 23 

prevent
data loss 30, 32, 45 

shock 17, 50, 58 

procedure
access controller shell 71 

add new hard drives 31 

add storage expansion enclosures 37 

disable drive migration settings 31 

electrostatic discharge (ESD) 31 

enable drive migration settings 32 

flush server-cached I/O 23 

migrate hard drives 47 

migrate storage expansion enclosures with 

drives 55 

redeploy original (replaced) storage server 71 

save a module profile report 30 

save a storage subsystem profile 30 

unmount file systems 24 

upgrade
storage server 63, 67 

profile
DS4000 Storage Server 30 

proofs of purchase 63, 66, 68 

publications, DS4000 Storage Manager 21 

purchase
entitlements 1, 63, 65 

host kits 63, 65 

Q
Quorum disk 68 

R
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Readers’  comments  —  we  would  like  to hear  from  you.  

IBM  TotalStorage  DS4000  

Hard  Drive  and  Storage  Expansion  Enclosure  Installation  and  Migration  Guide  

 Publication  No.  GC26-7663-00  

 We appreciate your comments about this publication. Feel free to comment on specific errors or omissions, 

accuracy, organisation, subject matter, or completeness of this book. The comments you send should pertain to 

only the information in this manual and the way in which the information is presented. 

For technical questions and information about products and prices, please contact your IBM branch office, your IBM 

business partner, or your authorized remarketer. 

For general questions, please call ″Hello IBM″  (phone number 01803/313233). 

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any 

way it believes appropriate without incurring any obligation to you. 

Comments: 

 Thank you for your support. 

To submit your comments: 

v   Send your comments to the address on the reverse side of this form. 

If you would like a response from IBM, please fill in the following information: 
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Company or Organization
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